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The Color SDS Touch Screen Data Logger (SDS8120 / SDS8140) provides the hardware
and software needed to meet industry standards for furnace temperature uniformity by
logging and generating temperature and data log reports.

It is easy to use and addresses the many industrial applications where data logging,
trending, and reporting are required. The product is available in either the 20- or 40-
channel version with user-defined inputs for each channel and comes with reporting
software to easily generate survey reports.

The easy to use Survey Template and Report Manager provide users with all of the tools
needed to generate uniformity reports. The Report Manager includes a report writer
that allows the user to set up reports to meet their specific requirements. The Template
Manager allows survey specific data to be created, updated and used during the
reporting process. All reports can be printed, saved electronically and emailed using
the software utilities. The SDS software tools, along with the data logger, combine to
create a powerful solution for data logging and reporting temperature uniformity
surveys.

Product Specifications

o User defined “logging” intervals as frequently as 10 seconds
e AC (90 -240V) and DC Power

o Rechargeable battery - Approximately 12 hours of “runtime”
e Dimensions: 16"D X 20"L X 8"H

e Password protected menu options

e FEasy calibration

e Web-page enabled real-time view

o Ethernetand USB serial communications

o 16-Bit A/D converter

e 1 gigabyte of on-board storage
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Degrees F. A/D Accuracy Accuracy Accuracy
At 1600 Degrees F

TC Type At 1600 Degrees  with thermistor

Min Max Full scale Full Scale F. error

B 32 3308 | 0.0124% 0.0179% 0.29 0.65
C 32 4208 | 0.0062% 0.0067% 0.1 0.47
E -328 | 1832 | 0.0031% 0.0032% 0.05 0.41
J -346 | 2192 | 0.0031% 0.0036% 0.06 0.42
K -328 | 2502 | 0.0031% 0.0045% 0.07 0.43
N -328 | 2372 | 0.0031% 0.0052% 0.08 0.44
NNM 0 1409 | 0.0031% 0.0033% 0.05 0.41
R -58 | 3214 | 0.0062% 0.0118% 0.19 0.66
S -58 | 3214 | 0.0124% 0.0133% 0.21 0.57
T -328 752 0.0062% 0.0119% 0.19 0.55

Table 1 - Thermocouple Types, Scaling, and Accuracy

*** Note: Accuracy at 1600 Degrees F with thermistor error requires SDS firmware
level 1.70 or later ***

Software Installation

You will find the SDS Reporter software CD that ships with the unit includes all the
reporting and administrative utilities. Insert the CD into the optical drive on your
computer and click the setup.exe file. You will be given a step-by-step instruction for
completing the installation process. See Installing the SDS Software section for more
details.

Changing the System Date and Time

The time and date that SDS uses are based on the time and date of the touch screen
operating system. To change the time and date, first shut down the SDS software
(Figure 1); note that this requires administrator access. Once the software is shut down,
double tap on the time shown in the task bar at the bottom of the screen on the
operating system desktop (Figure 2]. Change the date and time in the dialog box that
appears.
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Figure 1 - Option to Shut Down the SDS Software Figure 2 - Date and Time Change Dialog Box
(Administrator Access required)

Once you have changed the date and time, you will need to save the changes to the
operating system registry. This is done using the “SaveRegs” application. In most cases,
the “"SaveRegs” shortcut will be installed on the operating system desktop. Double tap
on the shortcut and save the registry settings. Then close the “SaveRegs” window.

Finding and Setting the IP Address of the Color SDS Data Logger

For certain functions, it may be necessary to find the IP address (the address that
identifies the device on a network] of the Color SDS Data Logger. A possible example of
this could be Connecting the SDS Data Logger to a Network. Less frequently, it may be
necessary to change the IP address of the data logger, or to change it from a dynamic IP
address assigned by the local network to a static IP address that does not change
(unless you change it or set the IP address back to dynamic].

To find the current |IP address of the data Instrument Information
- Sub Processor 4 Ver 0.00 —
logger, s_lmply open the Instrument Sub Processor 5 Ver 0.00
Information screen and scroll down to the Sub Processor 6 Ver 0.00
Screen IP Address (Figure 3) Sub Processor 7 Ver g-gg
\Sub Processor 8 Ver
Screen IP Address 192.168.1.222 l
Last Factory Calibration 17171900
Last Span Calibration 1/1/1900
Memory Usage 20448KB Il

N T

Figure 3 - Location of Screen IP Address in
Instrument Information screen

By default, the Windows CE operating system on which the data logger software runs
obtains IP addresses dynamically. This means that the IP address may change
depending on a number of factors. In order to change IP assignment or the IP address
itself, you will need to shut down the SDS software and access the operating system
Control Panel. This procedure is described below.
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To change the IP address of the Color

SDS Data Logger, first shut down the 11/29/2012 11:47:00 AM
SDS software. This requires About 4
administrator access. Voltage Calibration

CJ Trim

Datalog Deletion

Passcodes

Cold Junction Thermistor Calibration

Data Action
Exit Progra L]
| =3

Fiqure 4 - Exit Program option
(requires administrator access)

Next, click Start, Settings, and Network M pragrams

and Dial-up Connections (Figure 5). ¢ Favarites ¥
) Documents *

B Contral Panel

Figure 5 - Accessing the Network and Dial-Up
Connections

Double tap on the connection for the Color
SDS touch screen device (in the example,

it is called “SMSC91181"). An Ethernet
Driver settings window will appear, giving

you the ability to specify an IP address. To cH o4
. . . " — Ll
do so, click the Sp.ecn‘y an |P address Vo New  USE CapLe: B
radio button (see Figure 6). Then enter an Connection
IP address manually. Make sure that the T —y e oK
IP address does not conflict with another TP Addhess | Mame Servers |
IP address already assigned on the o P ackhocs ca b O —
netwo rk. automatically assigned to this

computer, If your netwark @ Specify an IP address

does not autoratically assign ) _
IP addresses, ask your network IP Address: 192.168. 1 222

You will also need to add a Subnet Mask A etrator fon an e, Subret Mask
and a Default Gateway. The subnet mask provicec D s

is usually already determined for the
network. A common subnet mask is
255.255.255.0; however, check with the
network administrator to be sure. The
default gateway is usually the address of
the network router or other device that is
responsible for routing network traffic.

Figqure 6 - Specifying an IP Address
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Calibration

The SDS data logger is calibrated prior to shipment. The calibration process is
available through the touch screen Menu on the data logger. Instructions for calibration
are included in this manual. Super Systems calibrates the SDS data logger using NIST
traceable instruments that are listed on the calibration certificate included with the
device. The default calibration is performed using a zero and span routine for the
millivolt range of 0 - 80mV unless otherwise specified on the purchase order. Ranges
and thermocouple types will be listed on the certification provided with the SDS data
logger. Each range that is being used should be calibrated. For a list of suggested mV
ranges by thermocouple types, please refer to Table 1 - Thermocouple Types, Scaling,
and Accuracy. Other calibration ranges are available upon request.

An input device will be used to input a specific type K thermocouple value and the data
logger value will be recorded. This will be performed at different temperatures and
printed with the certificate.

Getting Started

IMPORTANT: When using SDS Reporter with the Color SDS Data Logger, Options >
Color Screen Scanning must be selected. Refer to the section Options = Color Screen
Scanning for more details.

When logging data, the operator will use the on-board display to start and stop the data
logging / survey process. The first steps related to data logging are connecting the
inputs to the terminal strips on the data logger. Each terminal strip represents a single
analog board with 5 inputs. You can remove these terminal strips by pulling up on both
ends of the terminal strip.

Depending on the model number, you have either 20 or 40 input channels for data
logging. For each channel there will be a positive and negative connection which must
be attached to the appropriate input.

The operator defines an input type for each channel.

Once the inputs have been connected, the operator selects which inputs will be included
in the survey. This is done in two ways:
1. When a template has been selected, the input channels setup for the template,
as defined in the Template Manager, will be the selected channels for the survey.
It is strongly suggested that you select a template prior to running a survey. If
you want to create new templates, please see the section SOS 7Template
Manager. Survey Control and input selection screens are shown in Figure 7.
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Template 5 'i Inputs

Input 1 Selected
e Specl S . 3 |Input2 Selected
A G o : Input 3 Selected
a";“';wm“ 1LLY4,5676910 II'IDUt 4 Sel
ohdoditas Input 5 Selected .
Cycie e Input 6 Selected
T Input 7 Selected
- Input 8 Selected
e El Input 9 Selected
e S
Start Survey GoBack | Select/
Deselect

Figure 7 - Survey Control and Input Selection screens

IMPORTANT: Input channels defined in the Survey Template will override the settings in
the Select Input Channeloption once the survey is started. All channels are being data
logged at all times. The active inputs provide real time information on the display and
evaluation for stabilization, hottest TC and coldest TC. In the event that a TC is not
selected, it can be selected when using SDS Reporter for inclusion in the final survey
report.

2. Once a survey is started, the input selection can be updated on the data logger
using the Select Input Channels option.

09/10/2012 14.47.15

Survey =
Instrument Information

Chart Scaling

View Input Types

View Offsets

Edit Input Types o
Edit Offsets

Figure 8 - Select Input Channels Option in Main Menu

Analog Inputs

The Super Systems, Inc. 31631 Analog Board contains a group of five channels isolated from the
main DC power source. The board can be connected to thermocouples, voltage sources from
20mV full scale to 1.28 Volts full scale, or 4 - 20 mA current loops. Take caution when using
current loops to avoid damaging the input (see 4 — 20 mA Current Loop connections).

Thermocouple wires can be connected directly to the terminal blocks. The thermocouple
junctions should not be grounded. If they do touch a ground reference, all thermocouples on a
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board must have a common ground reference. If multiple thermocouples are connected to
different ground reference points, the accuracy of all thermocouples on the board cannot be
guaranteed to be accurate.

Voltage connections

Voltages from 0 mV to 1.28 Volts can be directly connected to the terminal blocks. When
measuring ground-referenced voltages, all references must share a common ground
reference. If the voltage sources are connected to different ground reference points, the
accuracy of all the voltage sources connected to the board need to be checked for accuracy.

4 - 20 mA Current Loop connections

Before connecting the current loop, insert the shorting jumper on the board for each channel
used to measure current loops. This jumper inserts the 62-ohm shunt resistor across the input
of the A/D. If multiple current loops are connected to one board, all must share the same power
supply and ground reference points or the accuracy of all the current loops need to be checked
for accuracy.

Survey Templates

The data logger will default to the last survey template used. To modify the template being
used, the operator can go to the Survey menu option. This data will be carried over for the
reporting process to make the reporting quick and easy. On the Survey Template screen there
are parameters, such as setpoint, that can be modified for a specific survey. After setting the
required parameters, the start survey process can be selected. This will timestamp the
selection and the data logger will log all channels that have been selected for logging.

The operator may receive deviation alarms depending on the current input and setpoint as well
as the alarm settings. The alarm will notify the operator when an input is outside the
plus/minus tolerance for the setpoint. The alarm information will display on the data logger
and show the number of channels above tolerance and below the tolerance. The survey
continues to run. It is simply providing the operator with the information on the display.

The operator can view the input channel data on a number of different screens. The overview
display will display all channels on the device.

At any time, the operator can view the data in real time from the computer using the SDS
Reporter software. When selected, the real time data option displays data every 10 seconds.
The system will update the data in 10 second intervals every minute. Follow instructions for
connecting the data logger to the PC.
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Figure 9 - Current Trends Screen (SDS Reporter)

While the survey is running, several options are available: To stop the survey, select Complete
Survey from the Survey Control screen (which can be opened using the Survey option from the
main menu). Use Mark Approach to add a timestamp to the survey on when the furnace was
heating up to its target temperature. Use Mark Survey Startto mark when the survey began.

Survey Control

Survey Run Time: 1 second
OUT of band HITC: 1 LOWTC: 3
STAB Timer (D:H:M) 0:0:0

Furnace Cliess -]
Survey Duration 30
Survey Tokerance 75,0
Survey simulated Load o
Survey Setpoint 500
Survey Dperator Bob
Survey Spexification
Number of TCs w0
C Gauge 5
TC Type [3
TC Spool SN
TC Spool Comection )
Active Inputs 1,2,3,4,56,7.8,9 10

[ esees | Vewowr |

a Appraa‘:h a survev sar

Figqure 10 - Survey Control Window (visible from the data logger during a survey)

Click View Surveys to view data on past surveys. Click View Chartto view the current chart of
data being logged.

After stopping the survey, other surveys can be taken by repeating the above steps. At any time,
all survey data can be downloaded to the PC using the Download Surveys and Data option on
SDS Reporter. Follow instructions for connecting the data logger to the PC.

Once the data has been downloaded, it is available for reporting. By clicking on the File > Open
menu option, the operator will be given the Report dialog to generate a survey report. Reports
use logged data and the user specified interval in the report. The report template that is
selected will form the final report view with all of the template data, survey data and additional
report parameters that are entered. The report templates are user-defined and should be
configured to meet your needs. All reports can be saved and displayed at a later date.
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Installing the SDS Software

IMPORTANT: The person installing the SDS Software must have administrative rights on the
computer(s) where the installation is taking place for the installation to be successful.

Double-click on the setup file, setup.exe, to start the auto-installation. (Avoid installing from
SDSSetup.msi, as this will not install prerequisites if necessary.) If there is no version of the
SDS Reporter running on the computer, the installation will prompt the user for the download
location (Figure 11).

i SDS Reporkter

Select Installation Folder

The installer will install S05 Reporter to the following folder.

T o install in this folder. click “"Mext". To install to a different folder. enter it below or click "Browse'".

Folder:
[c:nssisDss Browse... |

Disk Cost... |

Install S0S Reporter for yourself. ar for anyone who uses this computer:

 Ewernone

£ Just me

Cancel I < Back I

Figure 11 - SDS Reporter setup screen

Prerequisites for installing SDS Reporter include .NET Framework 2.0, SQL CE 3.5, and either
ActiveSync or Windows Mobile Device Center. The setup.exe program will check to make sure
that these prerequisites are installed and, if necessary, install them.

The default location is “C:\SSI\SDS". Click on the “Browse” button to select an alternate
location. Clicking on the “Disk Cost...” button will display the available computer drives onto
which the SDS Reporter can be downloaded, as well as the total space, available space, and
required space for each drive. Selecting the “Everyone” option will install the SDS Reporter for
all users on the computer, while selecting the “Just me” option will only install the
SDSReporter for the current user. Clicking on the “Cancel” button will prompt the user to
confirm exiting the setup without continuing. Clicking on the “< Back” button will display the
previous screen, which is the introduction screen for the installer. Clicking the “Next >” button
will continue with the installation process (Figure 12).

|2 SDS Reporter

Confirm Installation

The installer is ready to install SDS Reporter on wour computer

Click ""Mext" to start the installation.

Cancel [ e | s

Figure 12 - Installation ready screen
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Clicking on the “Cancel” button will prompt the user to confirm exiting the setup without
continuing. Clicking on the “< Back” button will display the previous page, which is the
installation setup page (Figure 11]). Clicking on the “Next >” button will install the software to
the specified location. Once the software has been installed, the installer can be closed. The
SDS Reporter software will now be ready to use.

If there is a version of the SDS Reporter already installed on the computer, the installer will
either re-install the software (Repair SDS Reporter option) or remove the software from the
computer (Remove SDS Reporter option) (Figure 13). Clicking on the “Finish” button will
proceed with the selected action. Note: The installer does not remove any subfolders in the
main SDS folder. These files will have to be manually removed.

& SDS Reporter

Welcome to the SDS Reporter Setup Wizard

Select whether vou want to repair or remowe SDS Reporter.

i+ Repair S0OS5 Reporter
¢ Remove SDS Reporter

Cancel I < Baclk I ' Finizh

Figure 13 - Repair/Remove SDS Reporter screen

Connecting the SDS Data Logger to a Network

Every SDS Data Logger shipped includes an Ethernet crossover cable that will connect the data
logger to a network. Once the data logger is connected to a network, the SDS Reporter
software will be able to find it during any searches.

Connecting the data logger to your network or directly to a PC can be accomplished using the
Ethernet port on your data logger.

Figure 14 - Location of Ethernet and USB ports
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If you are connecting the data logger to your network, you will need an Ethernet cable (the cable
provided is a crossover cable for direct connections to a PC). The cable is plugged into the data
logger Ethernet plug; the other end should be plugged into a network hub. If the IP Address of
the data logger needs to be changed, this can be done on the data logger through the Set IP
Address menu option.

If you are not putting the data logger on the network, you should use the Ethernet crossover
cable that has been provided with the device. Ethernet crossover cables are most often

used when connecting two Ethernet computers without a hub. An Ethernet crossover cable has
its send and receive wires crossed. When using a hub or switch, this is automatically done for
you.

With a crossover cable, you are forming a network between the computer that you are directly
plugged into and the data logger. There will be some network settings on the data logger and
on the computer that you will have to configure for the two devices to communicate.

Setting an IP address in the data logger is described in Finding and Setting the IP Address of the
Color SDS Data Logger above.

Network settings can be found through the Control Panelin Microsoft Windows.
Using the crossover cable will require the Local Area Connection to be modified.

In Windows Vista and Windows 7

In Windows Vista and Windows 7, open the Jgi oo st Convistion
Network and Sharing Center menu within B Network and Sharing ® omoie
Control Panel. Click “Change adapter settings”. . e _—

This will bring up a list of network connections,
including active and inactive ones. Right click Change adapter settings Creste Shortcut

on the name of the network to which the Color S

SDS Data Logger is or will be connected, and |5 e |

then click Properties.
Figure 15 - Accessing Network Connection

properties
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The network properties window will appear.
Click on the line that reads “Internet Protocol
Version 4 (TCP/IPv4])” and then click Properties.

In the Internet Protocol Version 4 (TCP/IPv4)
Properties window, you will need to select the
option for Use The Following IP Address. These
settings should match the settings on the Color
SDS Data Logger.

To change the network settings on your

computer you may need additional information.
If needed, please refer to the computer manual.

In Windows XP

The Properties can be changed by highlighting the connection and using the right mouse button
to click and select the Properties tab or by highlighting the connection and clicking on Change

setting of this connection.

Super Systems Inc.

U Local Area Connection Properties

Networkding | Sharing

Connect using:

¥ Intel{R) 825791 M Gigabit Network Connection

This connection uses the following items:

9% Cliertt for Microsoft Networks

31 irtual PC Network Fitter Driver

4Bl 05 Packet Scheduler

gFile and Printer Sharing for Microsaft Networks
] sie lntemet Praiocol Versinn S ICE/PLE)
I - |ntemet Protocol Version 4 (TCP/IPv4)
2T L Lne-Layer 1opology Uiscovery Mapper 170 Diver

& Link-Layer Topology Discovery Responder

Description

Transmigsion Cortrol Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

[ ok ][ cancel |

N

Figure 16 - Accessing TCP/IPv4 Properties

=
Internet Protocel Version 4 (TCP/IPv4) Properties @éJ
General

You can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
@ Use the following IP address:

IP address: 192,168 . 1 .229
Subnet mask: 255 . 255,255, 0
Default gateway: 192.168. 1 . 1

Obtain DNS server address automatically
(@) Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit

Figure 17 - Changing IP address settings
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LANM or High-Speed Internet

0 wireless Metwark Cannection LAM or High-Speed Inter..,  Connected Dell Wireless 1370 WLAN. ..
BIM| o3l Ares Conneckion LAM or High-Speed Inter...  MNetwark cable unplugged Broadcom Mekxtreme 57...
Disable
Yirtual Private hNetwork Connected Al Miniport (PPTP)

Bridge Connections

Create Shortout

Rename

Fiqure 18 - Network Connection Properties

Once the Local Area Connection Properties screen is displayed, the Local Area Connection
Properties tab should be highlighted. Click on Internet Protocol (TCP/IP) and then click the
Properties button to display Internet Protocol (TCP/IP) Properties.

-k liocal Area Connection Properties E]@ Internet Protocol (TCP/IP) Properties @E}
General | Advanced General
Conrnect using: You can get IP settings assigned automatically if vour netwaork, supparts

this capability. Otherwise, you need to ask your network. administrator for

9 Intel 21140Based PCI Fast Ethemet the appropriate IP seftings.

This connection uses the following items: () Oibtain an IP address automatically

B8, Client for Microsaft Networks (@ Use the following IF address
13 File and Printer Sharing for Microsoft Netwerks

IP address: 192 168 1 222
Subnet mask: 255 . 265 . 285, 0
Default gateway: 192 168 . 1 1

Description

Transmission Control Protocol/ntemet Protocol. The default (@) Use the fallowing DNS server addresses:

wide area network protocol that provides communication

across diverse interconnected networks. Prefened DINS server

1 Aliemate DNS ssrver
[[] Show icon in notification area when connectsd

Natify me when this connection has imited or no connectiviy

Fiqure 19 - Network Connection Dialog Boxes

In the Internet Protocol (TCP/IP) Properties window, you will need to select the option for Use
The Following IP Address. These settings should match the settings on the Color SDS Data
Logger.

To change the network settings on your computer you may need additional information. If
needed, please refer to the computer manual.

Connecting the SDS Data Logger to a Local Computer via USB

The data logger can be connected directly to a local computer using a USB cable and SDS
Reporter. Windows uses special software to transfer files and information between the data
logger and the local computer when connected via USB. If you are using Windows XP, this
software is called ActiveSync. If you are using Windows Vista or Windows 7, the software is
called Mobile Device Center. If the required software was not installed prior to installing
SDSReporter, the SDSReporter Setup utility (run from setup.exe) would have installed the
required software.
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Windows XP requires a driver for it to properly
connect to the data logger’s color touch
screen operating system. Install this driver, if
necessary, by selecting the “Check Screen
Driver Installation” option under the Help
menu in SDSReporter (Figure 20), and then
clicking “Start Driver Installation” on the next
screen.

£2 Super Systems inc. SDS Reporter

File 5D5 ©Options Mgkl
About

——  Install Color Prerequisites

| Color Screen Driver Installation
Check for Updates

Figure 20 - Color Screen Driver Installation option

If you are using an older version of SDSReporter, be sure to update it by clicking “Check for
Updates”, also in the Help menu, and then downloading the update when prompted.

To connect the SDS Data Logger to a local computer with USB, first make sure that the data
logger is turned on and that the SDS software is running on the touch screen. Next, identify the
USB connection point used to connect the data logger to the local computer (shown in Figure
21). To connect the data logger to the computer, you will need a USB cable with cable ends that
look like those in Figure 22.

T
[ oA

fu.yl'-l].

Figure 21 - Location of USB connection point for Figure 22 - USB connection types
connecting data logger to local computer Standard-A (left), Standard-B (right)

Connect the SDS Data Logger to the local computer via USB. If you are connecting the data
logger to the computer via USB for the first time, you may see a message on the screen saying
that Windows is installing drivers, especially on Windows Vista and 7. Windows may also ask you
if you want to set up the device. If this happens, allow Windows to install the drivers, but close
the device setup window from ActiveSync or Mobile Device Center.

NOTE: If there is any question as to whether
the computer is detecting the data logger and
connecting to it properly, check the "My l =5 o 4 Portable Devices (1)
Computer” window in Windows XP or the .L-a Moble evics 5 CUWIN

“Computer” window in Windows Vista and 7.

The data logger should appear in this window Figure 23 - Data Logger Device Icons in
with a mobile or portable device icon, as Windows XP (left) and Windows 7/Vista (right)
shown in Figure 23. Other devices, such as

Other
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smartphones, may also appear as part of the
same list.

Once the SDS Data Logger is connected to the computer via USB, start SDS Reporter.
Web Portal

The Color SDS Data Logger features a web-based portal that can be accessed by web browser,
using Ethernet, from any computer that is connected to the same network as the data logger.
The web portal displays current temperature readings for each thermocouple input.

To access the web portal, first open a web Instrument Information
browser (such as Internet Explorer or Firefox). g”g Erooess‘” g :er ggg M
. - ] rocessor er .|

Next, in the location bar, type Attp:// followed eub Pro £ 6 Ver 0.00
by the IP address of the data logger. One way Sub Processor 7 Ver 0.00
of finding this IP address is to obtain it from Sub Processor 8 Ver 0.00
the Instrument Information window, as shown  [Screen IP Address 192.168.1.222 |
in Fieure 24 Last Factory Calibration 1/1/1900

g : Last Span Calibration 1/1/1900

Memory Usage 20448KB |

N T

Figure 24 — Instrument Information screen and IP
address

Once you've entered the needed web address, you will see a screen that looks like the following

! = i
‘#\e\'
4
? SSI Model SDS 8120 Datalogger

one.

1 106.5 105.5 105.6 104.9
2 106.2 106.4 106.6 105.6

1064 1064 1068 1056
4 106.2 106 106.7 103.6
] 106 105.7 106.4 105.1

Fiqure 25 - Web Portal Screen

Home Screen

The default Home Screen for the SDS will display the temperature at each channel. The grey
bar along the top represents the 4 analog boards and the numbers along the left-hand side
represent the 5 channels for each board.
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Input 1 2 3 4

1 1696.6 1697.4 1697.1 1697.9
2 1696.7 1697.4 1697.3 1697.7
3 1696.6 1697.4 1697.4 1697.9
4 1696.6 1697.7 1697.4 1697.9
5 1696.6 1697.7 1697.6 1698.4

Fiqure 26 - Home Screen

Menu

Menu contains the list of operations that the SDS performs as well as other information about the unit.
The viewable Menu items change depending on the login value. The complete list of Menu items

includes:

User-Level Access [or Higher] Required:
e Survey

Instrument Information

Chart Scaling

View Input Types

View Offsets

Select Input Channels

Edit Input Types

Edit Offsets

Spool Correction

e About

Supervisor Access [or Higher] Required:

e Voltage Calibration
e CJTrim
e Datalog Deletion

Super Systems Inc.
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Administrator Access [or Higher] Required:
e Passcodes
e Cold Junction Thermistor Calibration
e Full Data Action
e Exit Program

Highest Level Security Access Required: — — Please call Super Systems Inc
* Configuration Technical Support (800-666-4330)
* Reset Calibration Dates before attempting to access any of
e Set Nominals >— these Menu items: Configuration,
e Set K Factors Reset Calibration Dates, Set
e SDX Control Nominals, Set K Factors, SDX
e Modbus Control _ Control, or Modbus Control.

8/24/2012 10:43:17 AM

Survey

Instrument Information
Chart Scaling

View Input Types

View Offsets

Select Input Channels
Edit Input Types
Edit Offsets

Realtime

Fiqure 27 - SDS Menu

Survey

This option contains the survey information and the controls to perform a survey. The
appropriate template can be chosen from the dropdown menu in the top right-hand
corner. The Edit Template button allows for changes to be made to the selected survey.
When editing a survey, pressing OK will make changes only for that particular survey,
while pressing Save will permanently change the template. The View Surveys button
will display a list of previous surveys from the selected time range. Once the template
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has been selected and any necessary edits have been made, press Start Survey to
begin.

Default Template

MName Default Template
Company

MNotes

Furnace ID

I Furnace Make/Model

Furnace Dimensions -
Temperature Type

Furnace Range 0
|| Furnace Type

Furnace Use

Furnace Class

Survey Duration 0 |
Survey Tolerance 0.0 I

|

|»

Edit Template

Figure 28 - Survey Window
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Instrument Information

Instrument Information

MODEL 31603 -
Power Status Fully Charged

DC Supply Volts 13.8

Data Log Status Logging

Main Processor Ver 1.13

HMI version 1.0.04

Sub Processor 1 Ver 1.10

Sub Processor 2 Ver 1.10

Sub Processor 3 Ver 1.10 .

‘ ‘ Go Back

Fiqure 29 - Instrument Information

Instrument Information displays the condition of several parameters for the SDS, and no
changes can be made to this screen.
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Chart Scaling
& 411454702363426 e

Chart Scaling

Max: 2000
Min: 0

Cancel

Fiqure 30 - Chart Scaling Window

Chart scaling allows the user to adjust the maximum and minimum degrees displayed
on the chart. To change, press the blue button with the max or min number, press OK,
then press Save.

View Input Types

This menu option displays the thermocouple type for each of the 20 channels. No
changes can be made to this screen.
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Input Input Type
Input 1
Input 2
Input 3
Input 4
Input 5
Input 6
Input 7

Tomsms b O

SAAARAARAARA

Figure 31 - View Input Types

View Offsets

View Offsets displays the offset values for each thermocouple channel on the SDS. No
changes can be made to this screen.
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Input 1 2 3 4
1 0 0 0 0
| 2 0 0 0 0
3 0 0 0 0
4 0 0 0 0
5 0 0 0 0
Figure 32 - View Offsets
Select Input Channels

Select Input Channels allows the user to manually determine whether a thermocouple
is included in a survey or not while the survey is running. First press Select Inputs.
Then, highlight the Input # to toggle between Select/Deselect. To save changes, press
OK.
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Select Input Channels [
Input 1 2 3 4

0y I S S I N

Select Inputs Return

Fiqure 33 - Select Input Channels

Inputs
Input 1
Input 2
Input 3
| Input 4
Input 5
Input 6
Input 7
Input 8
Input 9
Input 10 =

4 4

Figure 34 - Select Inputs
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Edit Input Types

Edit Input Types allows the type of thermocouple to be changed for any channel. The
drop-down bar contains a list of thermocouple types. Select the appropriate
thermocouple types. The Range Start and Range End correspond to the channels of the
SDS that will be changed. To change only one channel, set the Range Start and Range
End both to that number. To change all channels, the Range Start will be 1 and the
Range End will be 20. Any interval in between can also be used. Press Set Range Input
Types to save.

Edit Input Types
Input Type

Input
Input 1
Input 2
Input 3
Input 4
Input 5
Input 6
Input 7

Tomsms b O

l | [»]

B ]

Range Start: 1 Range End:

SNAAAAANRAAN

Set Range Input Types

Fiqure 35 - Edit Input Types

Edit Offsets

The Edit Offsets option will change the offset for each thermocouple. Press the blue
number button next to Select Input and enter the appropriate channel number. Press
OK. Then enter the Offset Value and press OK.

NOTE: These offsets should be used to address the calibration report parameters to
correct for a known deviation by individual channel at a specific temperature OR to
compensate for an individual thermocouple wire for each channel. All offsets that are
used can be displayed on the final report using the reporting tags.
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Clear Offsets

Figure 36 - Edit Offsets

Spool Correction

This menu item allows the thermocouple Spool Correction to be modified. First select
the temperature type from the drop down menu, then enter the spool correction value
and press Set Spool Correction to save. Press return to go back to the Menu list. The
thermocouple spool correction can be used to before a survey is run so that the data
displayed is corrected. You can also enter the TC offset in after the survey is completed
using the SDS Reporter software.

Super Systems Inc. Page 29 of 104
Color Touch Screen Data Logger Operations Manual



Offsets

Spool Correction: 0

Set Spool Correction

Return

Figure 37 - Set Spool Correction

About

This screen will display basic information about the SDS including the version and the
serial number. Nothing on this screen can be changed.
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SSi SDS
Serial Number: SDS001

1.0.0.8

Phone: (800) 666-4330
Www.supersystems.com

Go Back

Fiqure 38 - The About Screen

Calibration

Before using the SDS Data Logger in surveys, it is essential to ensure that the unit is properly
calibrated. This means that rawvoltages measured by instruments connected to the data logger
are converted (scaled) to values that accurately reflect the actvalvoltages. The calibrations that
the user will typically need to perform (before using the data logger in surveys] are the Voltage
Calibration and Cold Junction Trim Calibration (also called CJ Trim]. First, the Voltage
Calibration will be performed to ensure that the voltages measured by the leads connected to
each thermocouple are scaled correctly. Second, the CJ Trim will be performed to ensure that
the temperature measured at each data logger terminal (where the cold junction is created) is
correctly scaled. Both types of calibration require a sourcing device and thermocouple wire. The
sourcing device should be calibrated and certified to generate accurate voltages before these
calibrations are performed.

IMPORTANT: Do not perform any of these calibrations without a sourcing device that is properly
connected and sourcing voltage into the proper inputs on the Color SDS Data Logger. Running a
calibration without a sourcing device that is providing voltage into the unit may require
additional calibration steps.

Voltage Calibration

The leads that connect to each input thermocouple measure the voltage generated by that
thermocouple. In most cases, the voltage that the data logger detects (the raw voltage] is
slightly different from the actual voltage generated by the thermocouple. When properly
performed, a Voltage Calibration (also called an Input Calibration) ensures that the SDS Data
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Logger software properly scales the raw voltage so that an accurate temperature can be
calculated. The Voltage Calibration consists of two parts: a Zero Calibration and a Span
Calibration. A Zero Calibration ensures that the raw voltage is scaled properly when the actual
voltage at a thermocouple is zero volts. A Span Calibration ensures that the raw voltage is
scaled properly when the actual voltage is 90% of the upper limit of the desired range (for
example, 72 mV when the upper limit of the range is 80 mV).

Figure 39 shows what the Voltage Calibration screen looks like.

Olilalc AT AallOo
Input 1 2 3 4
1 0 0 0 0
2 0 0 0 0
3 0 0 0 0
4 0 0 0 0
5 0 0 0 0

80mV  ——

Zero T Span

All 0O Use Selected Select Inputs

Figure 39 - Voltage Calibration screen

The horizontal row of numbers represents each circuit board containing five inputs. The
vertical column of numbers represents each individual input. A 20-input SDS Data
Logger will feature four circuit boards depicted on this screen, while a 40-input unit will
feature eight circuit boards. Since each board has five inputs, a Voltage Calibration
usually involves five inputs on the same board at one time. A single input can be
calibrated if it is suspected that the temperature reading associated with one input is
incorrect.

Range Value: The mV value shown in the drop-down box represents the range value for
the particular kind of thermocouple wire that you are using in the calibration. Pressing
the question mark (“?”) will bring up a window that shows the range value specific to
various kinds of thermocouple wire.

Zero or Span: Check “Zero” to perform a Zero Calibration. Check “Span” to perform a
Span Calibration.

All or Use Selected: Check “All” to calibrate all inputs. Check “Use Selected” to
calibrate a group of inputs selected by pressing the Select Inputs button and choosing
the inputs that you want to calibrate.
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Set up your calibration device as needed. When ready to begin calibrating, press
Calibrate.

Figure 40 - Setting Up A Voltage Calibration Figure 41 - Voltage Calibration (Span)

Ready to Begin

Use the results of the calibration to set up offsets for the SDS Data Logger. Editing
offsets is described in the “Edit Offsets” section above.

CJ Trim

For the Trim calibration, TC wire should be used. The trim calibration is performed by
connecting a thermocouple calibration device to each input and outputting a trim
temperature that should be equal to the expected operating temperature. For example,
the calibration could be completed using an output temperature of 1700°F. After the
zero calibration and span calibration, the temperature may read 1701.5°F instead. This
type of calibration should be used instead of the regular cold junction thermistor
calibration unless the cold junction temperatures are reading a temperature that is
much too high for what the ambient temperature could possibly be. A cold junction
thermistor calibration can be used in this instance when need be, but the Trim
Calibration is preferred.

IMPORTANT: Before performing this calibration:

1. Ensure that a sourcing device is properly connected and sourcing voltage into the proper
inputs on the Color SDS Data Logger.

2. Ensure that the input types are set up correctly. See View Input Types and, if necessary,
Edit Input Types.

3. If the data logger has been brought inside from a cold environment, wait 30 minutes
before performing the Cold Junction Trim Calibration. This will provide enough time for
the data logger to reach a stable temperature.

To perform a cold junction trim, first select the thermocouple type from the dropdown
list. Select the inputs that will be included by pressing the Select Inputs button. Enter
the Target Value and press Calibrate.
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Select Inputs Return

Fiqure 42 - CJ Trim Screen

Cold Junction Thermistor Calibration

This procedure is performed by Super Systems Inc. before the SDS Data Logger is
shipped. In most cases, the procedure will not need to be performed in the field. If a
situation should arise where a cold junction calibration may need to be performed in the
field, please contact Super Systems Inc. Technical Support at 800-666-4330.

Datalog Deletion

The Color SDS Data Logger includes an option to delete log data files and survey data
files. This option is useful when these data files are no longer needed or when removing
them would free up space on a storage card nearing its full capacity. The Datalog
Deletion screen (Figure 43) allows you to change the date and time range of the files
that will be deleted (Start Date and End Date]. The Delete Log Data button will cause
only the log data files to be removed, while the Delete Survey and Log Data button will
delete both the survey data and log data files.
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Datalog Deletion

Start Date: End Date:
10/24/2012 12:00:00 PM 10/24/2012 12:00:00 PM
Messages

Delete Log Data Delete Survey And Log Data

Figure 43 - Datalog Deletion Screen

Passcodes

This screen allows the user to set the passcodes to access the higher-level functions on the
SDS. To change either passcode, press the corresponding button, enter the new code, and
press OK.
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Passcodes

Supervisor Passcode:
Administrator Passcode:

Fiqure 44 - Passcode Change Screen

Cold Junction Thermistor Calibration
Please refer to the Calibration section above for more details.

Full Data Action

Full Data Action allows you to configure the way in which the SDS software handles data logging
and data log files as the storage card nears its full capacity. This can happen as data log files
are continually added to the storage card, eventually leading to the card running out of storage
space. As shown in Figure 45, there are two choices in this menu: Automatic Deletion and Stop
Datalogging.

Automatic Deletion causes the SDS software to delete data log files (starting with the oldest)
automatically as the storage card nears its full capacity; it will not delete data log files that have
been written less than 30 days before the current system date and time. For this reason, it is
important that the system date and time be set correctly when this setting is used and the
storage card is nearing its full capacity. For more information on setting the system date and
time, refer to Changing the System Date and Time.

Stop Datalogging causes the SDS software to stop logging data to the storage card when the
storage card is nearing its full capacity. When this occurs, a message box will appear indicating
that data logging has stopped. Click OK to close the window. In order to resume data logging,
you will need to restart the Color SDS Data Logger. For more information on deleting data log
files, see the section on Datalog Deletion.
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Full Data Action

Automatic Deletion ~
Automatic Deletion
Stop Datalogging

Save Close

Figure 45 - Full Data Action options

Exit Program

Selecting this option allows you to exit the Color SDS Touch Screen program. A confirmation box will
appear when you select this option (Figure 46). There are very few situations where this action would
need to be performed.

Shut down interface

Yes || Mo

Figure 46 - Shut Down Interface confirmation

Configuration
The Configuration Menu contains the following items:

Communications Setup. This menu item allows you to change the COM port
number, address, and baud rate of the communications port used to connect the
touch screen interface to the SDS mainboard.

Compact Database. When clicked, Compact Database optimizes and reduces the
size of the database contained on the storage card.

Read/Write Data. Using this feature, you can view the raw data on the underlying
hardware and also write data to the underlying hardware. This feature should not
be used in most circumstances.

About. This option simply shows the About screen for Super Systems SDS, as
shown in Figure 38.

Shut Down Software. This option shuts down the SDS touch screen.

Set Serial Number. This feature allows you to change the serial number of the
touch screen software. This setting should not be changed.

Degree Type. This feature allows you to change the unit of measurement used for
temperature—degrees Fahrenheit or degrees Celsius.

Product Type. This feature allows you to change the SDS product type as it is
known to the touch screen software.
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e Thermistor Calibration. This feature
allows for calibration of the ambient
thermistor (pictured in Figure 47)
and internal thermistor.

Fiqure 47 - Location of Ambient
(External) Thermistor

Configuration

Thermistor Calibration

Go Back

Figure 48 - Configuration Menu

IMPORTANT: Before attempting to access Configuration features, please contact Super
Systems Inc. Technical Support (800-666-4330).

Reset Calibration Dates

To change either of these dates, press the corresponding button and enter the new
date. Press OK to save.
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Reset Calibration Dates

Last Factory Calibration Date: 1/1/1900

Last User Span Calibration Date: 1/1/1900

Change Last Factory | Change Last Span

Calibration Calibration

Fiqure 49 - Reset Calibration Dates

IMPORTANT: Avoid resetting calibration dates without first contacting Super Systems
Inc. Technical Support (800-666-4330).

Set Nominals

Nominals are calibration constants used in the process of converting raw analog data to
voltage values. The Set Nominals menu provides the ability to reset calibration
constants for all inputs, or for a specified set of inputs, to default values.

A user may decide to use this feature if, for example, temperature readings from the
SDS are deemed to be outside a certain acceptable range and subsequent calibrations
are not successful. When the calibration constants are reset, the device is placed in an
uncalibrated state and will require recalibration. If recalibration does not result in
temperature readings that are within an acceptable range, it is likely that the SDS has
experienced hardware damage and will need to be shipped to Super Systems Inc. for
repair.

The Set Nominals screen is shown in Figure 50. To reset all nominals, simply select the
checkbox labeled “All” and then press the Set Nominals button.
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Set Nominals

All T Use Selected Select Inputs

Set Nominals Return

Figure 50 - Set Nominals

To reset nominals for specific inputs, first select the checkbox labeled “Use Selected”
and then press the Select Inputs button. The Select Inputs screen will appear. Select
each input for which you would like to reset the nominals, and then press Select
Highlighted for each one. Note that you may enter a range of inputs using the “Select
Range” feature. These screens are shown in Figure 51. Once you have selected the
specific inputs for which you want to reset nominals, press Return and then press Set
Nominals on the Set Nominals screen.
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Set Nominals

Al = Use Selected Select Inputs

Set Nominals Return

Select Inputs

Input 1

Input 2 |
Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Innut 9 [

»

Select Range: st ENEEY

Figure 51 - Use Selected Inputs in Set Nominals Screen

IMPORTANT: Avoid setting nominals without first contacting Super Systems Inc.
Technical Support (800-666-4330).

Set K Factors

K Factors are mathematical coefficients that help correct for changes in outside
temperature. When correctly programmed, K Factors help minimize the effect of
outside temperature variations on thermocouple temperature readings. It is possible to
adjust K Factor settings from the Set K Factors menu, but doing so is not recommended
without first contacting Super Systems Inc. Technical Support. See the notice below.

IMPORTANT: Avoid adjusting K Factors on any channel without first contacting Super
Systems Inc. Technical Support (800-666-4330). Incorrect adjustment of K Factors will
likely result in incorrect temperature readings.
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Input Value =
Input 1
Input 2
Input 3
Input 4
Input 5
Input 6
Input 7
Input 8
Input 9
Input 10

OO0 OO0 000 OO

Set Value Return

Fiqure 52 - Set K Factors

SDX Control

By selecting Run for SDX Control, the SDS will run a program called SDX that monitors
thermocouples to ensure they are calibrated properly using the SDX software module.
SDX is available through SSi.
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Sdx Control

Sdx Running

Return

Figure 53 - SDX Control

IMPORTANT: Avoid running SDX without first contacting Super Systems Inc. Technical
Support (800-666-4330).

Modbus Control

Running Modbus Control will enable the Modbus protocol to read and write registers.
To set this up, press Run, then determine the range of Modbus registers that will be
monitored. Press OK to save.
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Modbus Control: Not Runnin
Date Error

Return

Figure 54 - Modbus Control Not Running Screen

Run Modbus Control

New start Range: |
New End Range: |

Fiqure 55 - Run Modbus Control Window
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IMPORTANT: Avoid running Modbus control without first contacting Super Systems Inc.
Technical Support (800-666-4330).

SDS Reporter

IMPORTANT: When using SDS Reporter with the Color SDS Data Logger, Options >
Color Screen Scanning must be selected. Refer to the section Options = Color Screen

Scanning for more details.

Figure 56 - SDS Reporter initial screen

When the SDS Reporter software is started up, the user sees the above screen (Figure 56). The
four menu options to choose from are: File, SDS, Options and Help. There are four buttons to

choose from: New D , Open ﬁ, Save E, and Print &

File Menu Options

File 2 New /New Button D

The New option allows the user to create a new report that will include the report properties,
the trend chart, and the TC data (Figure 57). Note: the selected tab will be in Red when it is
active only for the three main tabs - Report Properties, Chart, and Data.
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= Super, Systems inc. SDS Reporter

File sSD5 Options Help

MEIEIRS

Report Properkies ] Chart] Data I

Report lSur\-’ey Parameters ] Survey Details ] Thermocouples | Survey Box] Furnace ] Controller ] User Defined Comparisoncheck] ComparisonCheckz

[Drata Sources

Diata | | _l
Report Template: | |_|

SDS Report
Repart Heading | Title | |

Survey Resulks (Pass/Fail) | |

Motes

Figure 57 - Report Properties Tab

File - Open / Open Button =

The Open menu option will allow the user to choose an existing report from a common Windows

Open dialog box. The software will open the dialog box in the “SDSReports” folder (typically,
C:\SSI\SDS\SDSReports) for existing reports ((SDSReport] to open.

The Report Properties tab contains several tabs, which in turn contain the information that
makes up the report. The first tab is the Report tab (Figure 57), which contains the data to use

for the report, the report template to use, the report heading or title, the survey results, and any
notes about the report.
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Report Properties | Chart | Data i

Report ]Survey Parameters 1 Survey Details ] Thermocouples | Survey Box ] Furnace ] Controller ] User Defined | ComparisonCheck | ComparisonCheckz

Data Sources

Data | | _I
Report Template: | |_I

505 Report
Repart Heading | Title | |

Survey Results (PassiFail) | |

Motes

Figure 58 - Report Properties Report Tab

Clicking on the open box, —| , next to the "Data” field will display a screen from which the
user can select the interval time (ten seconds, twenty seconds, thirty seconds, one minute, two
minutes, or five minutes) and also the specific survey to use (Figure 58). This screen will only
display survey data that has already been downloaded (SDS — Download Surveys and Data).

&= Load Survey Data = 1O =]
ﬁtalntewal: L m
[Maral Extry] [SDS505000] 04,/25/2006 11: - 4:00 P -
[Manwal Entry] [SDS505000) 04/24,/2006 10:45 FM - 3:3

[Manual Extry] [SDS505000] 04242006 4:16 PR - 4:20 Pk

[Marnual Extry] [SDS505000] 04242006 12:48 P - 1:46 P

Template2: [Super Syztems lnc - Batch 1] [SDS505000] 04,07 /2006 12:37 P - 12:42 P

SDS5505000; [SDS505000] 04072008 1210 P - 12:27 P

Template2: [Super Svstems lnc - Batch 1] [SDS505000] 0407 /2006 10:50 Ak - 10:53 Ak

Template2: [Super Syztems lnc - Batch 1] [SDS505000] 0407 /2006 10:27 Ak - 10:23 Ak

[Marnual Extry] [SDS505000] 04042006 10:00 Ak - 17:00 A ;I
pdvanced: Manually Create Survey Fecord

Cancel Uze

A

Figure 59 - Load Survey Data screen

The default interval is one minute. Select the survey to use and click on the “Use” button.
Information included with the data sources is: Template Name, [Company Name - Furnace Id],
(Survey box Serial number), and the date/time range of the survey data. Any manual entries will
have [Manual Entry] at the beginning. See the section Manually Creating a Survey Record for
information on how to add a survey record manually. Clicking on the open box next to the
“Report Template” field will open a dialog box from which the user can select the specific report
template to use for the report. The software will open the dialog box in the
“SDSReportTemplates” folder (typically C:\SSi\SDS\ReportTemplates) for existing report
templates to use. The “Report Heading / Title” field is for the heading or title of the report and
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the “Survey Results (Pass/Fail]” field is for the results of the survey. The “Notes” field is for any
general notes for the report.

Manually Creating a Survey Record

Clicking on the “Advanced: Manually Create Survey Record” link from the Load Survey Data
screen will allow the user to create a survey record to use. Clicking on this link will display the
“Manually Create Survey Record” form (Figure 60). Five pieces of data are required to manually
create a record: the SDS model, serial number, the start time and date of the survey, the end
time and date of the survey, and the TC Spool Offset. All data will need to be downloaded from
the SDS either before or after this process in order to get data. To download all data, please
refer to section SDS = Download Surveys and Data.

2 Manually Create Survey Record @|§|@

|Jze this form to manually create a survey record. This may be uzeful in certain
zituations where survey data cannot be obtained from the listed survey records.

Survey Box Model |SDS Touch Screen j
Survey Box Senial Number; |SDS|JD1

Survey Sttt 11000048+ | 1247042
SurveyEnd | 2ppoopM | 1241042

TC Spool Offset: |0
Cancel Add Record

Figure 60 - Manually Create Survey Record form

The drop-down list next to “Survey Box Model” contains a list of the available models. Make
sure to select the appropriate Color SDS Data Logger. Select the model type (the Color SDS
Data Logger is referred to as “SDS Touch Screen”). Enter the SDS serial number on the next
line, “Survey Box Serial Number”. The serial number can be found in the About window, as
discussed in the About section. The process for selecting the start date/time and the end
date/time is the same. To select a date, click on the down arrow next to the time listed. This
will bring up a calendar from which the user can select a new date (Figure 61). Select the new
date by clicking on it.
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2 Manually Create Survey Record

Uze this form bo manually create a survey record. This may be useful in certain
situations where survey data cannot be obtained from the listed survey records.

Survey Box Model: |SDS Touch Screen ﬂ
Survey Box Serial Number: |5DSDD‘|

Survey Sta: [11-p000aM | 12710412
Survey End: | 2pponp + | 12410412

LN IEES Pl December, 2012 [N

Sun Mon TueWed Thu Fri Sat
Caticel 1

2 3 4 5 B 7 8
5 40 11 12 13 14 15
16 17 18 19 20 21 22
23 02 2 2% 27 28 29
<V

T Today: 171072013

Figure 61 - Select new date

The date of the survey start /end is listed to the right of the drop-down list. To select a time,
click on the hours, minutes, seconds or “AM/PM". The selected field will be highlighted. Each
field can be changed by using the up or down arrows on the keyboard. If the survey start date is
later than the survey end date, a message will be displayed to the user and the record will not
be added (Figure 62).

Error x|

Q Error: Surve'y skark date is after survey end date

Figure 62 - Survey start/end date error message

Enter the TC spool offset and click on the “Add Record” button to add the record. Clicking on
the “Cancel” button will cancel the add process and bring the user back to the “Load Survey
Data” dialog box. If the add was successful, a message box will be displayed (Figure 63].

SDSHeporter =

@ The record was added.

Figure 63 - Record Add successful message

The added record will be displayed chronologically in the top of the list. Any record manually
added will begin with “[Manual Entry]” (Figure 64). If the manually created survey is less than
one second, it will not be displayed in the list.
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&= Load Survey Data

D ata Interval: |1 P irite

[Marnual Entry] [SDS505000] 04252006 11:30 Ak - 4:00 Pk

[t arnual Entip] [SOS505000] 04242006 4:16 Pk - 4:20 Pk

[Manual Entry] [SDS505000] 04/24/2006 12:46 Pk - 1:46 Pk

Template2: [Super Syztems Inc - Batch 1] [SDS505000) 0407 /2008 12:37 Pk - 12:42 P4
SDS505000: [SDS505000) 044072006 12:10 PR - 12:27 P

Template2: [Super Syztems lnc - Batch 1] [SDS505000) 04,07 /2008 10:50 Ak - 10:53 Abkd
Template2: [Super S stemsz Inc - Batch 1] [SDS505000] 0407 /2008 10: 27 Akd - 10:23 Ak

b anual Entry] [SDSE05000] 04042006 10:00 &k - 11:00 &8
TemplateZ: [Super S_l,lstems Inz - Batch 1] [SDS505000] 02527 2006 11:04 464 - 17:08 Akd

Advanced: bManually Create Survey Record

Cancel I Usze I

Figure 64 - Manual entry on Load Survey Data form

NOTE: Most of the “Report Properties” tabs (Report, Furnace, Survey Box) will need to be filled

out manually as well.

The next tab is the Thermocouples tab (Figure 65). This tab contains the information about the
thermocouple settings and it also lists the active thermocouples. The information in the
thermocouple settings includes: the temperature type (F or CJ, the number of thermocouples,
the number of TCs used in the report, the thermocouple type, the thermocouple gauge, the
thermocouple spool number, whom the thermocouple was calibrated by, the date the
thermocouple was calibrated, and the thermocouple spool correction factor. Clicking on the

“Change” button will allow the user to change the spool correction (Figure 66).

Report Properties l Chatt l Data l

Thermocouple Settings

Temperature Type (F or ) I:I
Mumber of Thermocouples I:I # Ts Used in Report I:I

Thermocouple Type I:I
Thermocouple Gauge I:I

Thermocouple Spool Mumber I:I
Thermocouple Calibrated by I:I
Calibration Date I:I

Thermocouple Spool Correction Fackor I:I Change |

Active Thermocouples

1 s 11 ™ 16 21 26 ™ 31 [~ 36
ez rz I ¥ 17 ez ez [~ 32 [~ 37
3 [ a 13 ™ 18 | 123 28 ™ a3 -
4 e 14 J_ g I~ 24 (= [~ 24 [~ 39
s [~ 10 [~ 15 [~ 20 | 125 (| [~ 35 [~ 40

Define Contral TC Wiew Off sets used in Surve: Yiew Individual TC Correction Fackors

Feport I Survey Parameters ] Survey Detalls  Thermocouples lSurvey Box I Furnace ] Contraller ] User Defined | ComparisonCheck | ComparisonChecks

Figure 65 - Report Properties Thermocouples Tab
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Mew Spool Correction Factor Dialog =]
Fleasze enter the new offset
Cancel I

Fiqure 66 - Spool Correction screen

All values displayed to the users are corrected. That means if there is a defined offset for the
TC Spool and a channel offset, the user would be shown the net result of those offsets into the
value displayed.

There are checkboxes for a possible forty thermocouples, but only the active thermocouples will
have checks in the checkboxes. Clicking on the “Define Control TC" link will allow the user to
select the TC or TCs that will be the control TC(s) (Figure 67). The operator can select any of the
thermocouples to be the control TC(s) and provide an optional description for that TC.

Define Control Thermocouples =]

CHraeck off fre ffrarmocouodas mdecft are confod Tl You map ako
LOVIE 3 dESCHDiorT for eaclt coriod T

D escription D escription

wo=~ o &M 2

77T 773773737771 171717
77T 173771373771 171717

Bccepk | Cancel |

Figure 67 - Define Control TC screen

Clicking on the Accept button will set the selected control TC(s). Once a control TC(s) has been
selected, the TC's number will be in Red on the “Active Thermocouples” section of the
Thermocouples tab. The thermocouplels] that is identified as the control TC will not be used for
the TC summary when identifying hottest and coldest channels.

Clicking on the "View Offsets used in Survey” link will display a list of the offsets that were used
on the survey (Figure 68). All values that are displayed to the users are corrected values. That
means the Offset defined for these TCs have already been incorporated into the value the
operator would see. |F there is a value for the TC Spool Correction Factor, that value will also
be incorporated providing a corrected view for the user.
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N T
TC Il:lffset I
TCA a
TCZ2 o
TCZ o
TCH a
TC10O a
T o
TC1= o
TC1S a
TC1E a
TC139 a

Close I

Fiqure 68 - TCOffsets screen

Note: Checking or unchecking TCs on the Thermocouples Tab will affect the TCs plotted on the
Chart Tab.

The Thermocouples tab also includes an option to view and edit individual TC correction factors
(see Figure 69). Once these correction factors are in place, they will be applied to TC values
from survey data. These corrections will be reflected in the report generated by SDS Reporter.
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Report Properties |Chart |Data 1

EBX

1€ Corrections

Caomections

Report ] Survey Paramekbers ] Survey Details Thermocouples lSurvey Box ] Furnace ] Caontraller ] User [

Thermocouple Settings 1 1
Temperature Tvpe (F ar C) I:' 2 0

3 05
Mumber of Thermocouples # TCs Used in Report 4 1]

5 05

Thermocouple Type I:l
Thermocouple Gauge I:l

Thermocouple Spool Mumber I:I
Thermocouple Calibrated by I:'
Calibration Date I:I

Thermocouple Spool Correction Factor I:l Change |

Active Thermocouples

6 |_=he=l Bie==] E2==] Eee==] Eai===i Sef
s [ 12 [ 17 [~ 22 [~ 27 [ 32 [ 37
s iz 18 [z [T T3 [ 38
g |_EME] BloE] S Beonn ] Esam Beo)
Mo [T15 [T20 [T2 ["30 [ 3 [ 40

<] <l <l <l <]
L B R

Define Contral TC Wigw Offseks used in Surve: Wigws Individual TC Correction Fackors

Close Save | Edit | =]

Figure 69 - Viewing and Editing Individual TC Correction Factors

The TC correction factors are passcode protected in the SOSReporter.ini file contained in the

SDS Reporter installation folder (typically, the “C:\SSi\SDS" folder). The default passcode is 2.
To change it, open the SDSReporter.in/ file and add this line in the [SETTINGS] block of the .ini
file:

PASSCODE=x
Where xis zero or a positive integer.
The next tab is the Furnace tab (Figure 70), which contains the furnace ID, the make and model

of the furnace, the furnace type, the furnace use, the furnace’s operating range, the furnace
dimensions, the furnace class (newer versions only), and an optional image of the furnace.
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Report | Survey Parameters | Survey Details | Thermocouples | Survey Box | Furnace | Contraoller | User Defined

Furnace Details

Furnace I |# 105 |

Furnace Make | Maodel |Ipsen 1542 |

Furnace Tvpe |'-.-'acuum - 2Zbar Quench |

Furnace Lse |Heat Treaking |

Furnace Operating Range |1E|EIE|—24IIIEI |

Furnace Dimensions |6E|" = 60" |

Furnace Class I:l

Load Map Inmage

i

Fiqure 70 - Report Properties Furnace Tab

Clicking on the open box next the image frame will open a dialog box where the user can search
for an image of the furnace to use.

The next tab is the Survey Box tab, which contains information about the survey box itself, such
as the make and model, the serial number, whom the survey box was calibrated by, and the
calibration date (Figure 71).

Repork ] Furnace '

~| Thermocouples ] Survey Details ] Surveyw Paramekters ] Conktraller ] User Defined ]

Surwvey Box

Survey Box MakefModel | |

Survey Box Serial Mumber I:I

Survey Box Calibrated Byw | |

Surwveyw Box Calibration Date | |

Fiqure 71 - Report Properties Survey Box Tab

The next tab is the Survey Details Tab (Figure 72). The Survey Details tab contains the company
name, the survey start date, the survey duration, the actual duration of the survey, the survey
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specification(s), whom the survey was performed by, whom the survey was approved by, the
date range for the survey, and the due date of the next survey.

—Survey Dekails

Company Mame ISuper Swskems inc |
Surwey Sktark Dake IDZ,n'lD,l'DE- F:51:26 PM |
Surweyw Duration IDD:SD:DD Ackual:
Surwey Specificakions I.ﬂ.MS 2F50-C
FPerFarmed By ITim Kell

Date Ranges For Survey I

|
|
Approved By I |
|
|

Mexk Survey Due I

Figure 72 — Report Properties Survey Details Tab

The next tab is the Survey Parameters Tab (Figure 73). The Survey Parameters tab contains: the
survey tolerance, the survey setpoint, the overtemp setpoint, the simulated load in pounds, and
the microns.

The Cooling/Heating combo box affects tags:

e <5DS:0V>
e <5DS:0D>
e <SDS:0VT»>

Heating is default. If Cooling is selected, values below the tolerance range are thought to be
overshot instead of above the tolerance range (as they are thought to be for Heating].
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Report Properties | Chart | [Data |

Report  Survey Parameters lSurvey Details ] Thermocouples ] Survey Box ] Furnace ] Conkraller ] ser De

Survey Parameters

Survey Tolerance [+/-] | |

Survey Setpoint | |

Owertemp Setpoink | |

Simulated Load (lbs) | |

Microns | |

HeatinConiing .

Figure 73 - Report Properties Survey Parameters Tab

The next tab is the Controller Tab (Figure 74). This tab contains the Controller manufacturer,
the controller model, and the instrument type (newer versions only) in the “Temperature
Controller Settings™ area and this tab also contains the PID Settings: cycle time, dead band,
output limit, PB (Gain), rate, and reset.

Repork ] Survey Paramekers ] Survey Details ] Thermocouples ] Surwey Box ] Furnace

Temperature Controller Settings

Conkroller FFg. |H0neywe|l |

Contraoller Model |I_IDC 300 |

Instrument Type I:I

PID Setking=

Cycle Time |2|:| |
Dead Band | |
Cukput Limit [too |
FE (Gain) [3.7o |
Rate [-z5 |

Reset |1 25 |

Figure 74 - Report Properties Controller Tab

The User Defined tab contains twenty fields that can be defined by the user and included in the
report. To create a user defined field, click on the “Modify User Defined Fields”. This will
display a screen that will allow the user to edit the fields (Figure 75). The user can type in the
name or description of the field and click the “Save” button.
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Eters | Survey Details | Thermocouples | Survey Box ] Furnace] Controller User Defined | ComparisonCheck | ComparisoncChecks
Edit User Defined Fields
'

Modify User Defined Fields - =2
User Defined Tag 1| User Defined 1; |User Defined Tag 1
User Defined Tag 2| User Definad 2: |Ussr Defined Tag 2
User Defined Tag 3| User Defined 3 |User Defined Tag 3
User Defined Tag 4| User Defined 4; |User Defined Tag 4
User Defined Tag S| User Defined 5 |User Defined Tag 5
User Defined Tag 6| User Defined 6; |User Defined Tag 6
User Defined Tag 7| User Definad 7: |Ussr Defined Tag 7
User Defined Tag 8| User Defined g |User Defined Tag 8
User Defined Tag 9 User Defined 9; |User Defined Tag §

User Defined Tag 10 | User Defired 10: |User Defined Tag 10
User Defined 11| B : — = -

Figure 75 - User Defined Fields screen

Comparison Check
SDS Reporter includes two Comparison Check tabs, as shown in Figure 76. The two Comparison Check
tabs perform the same function with different defined data sets.

=
0| | d| &

Report Properties } Chart} Data 3

Reeport ] Survey Parameters I Survey Details } Thermacouples ] Survey Box ] Furnace ] Cantroller ] User Defined  ComparisonCheck 1 ComparisonCheckz

Preview Report | Print Report ‘ Contral Low High
Compatision TCs |1 |2 |3
Furnace ID Adjacent TCs |4 |5 |e

Set Point Compatison Test TJC Wire Correction Fackor | | |

Furnace Class I™ Use Custom Wire Corrections

111

Ambient Temp

Comparison Test T/C Spool Mumber AcceptfReject Criteria |0

Header Text Body Text
Proecs Comparisan Comparisan | Comparison | Comparison | Adjacent TC adiacent TC Adjacent .?:nlaﬁgﬂé ARC?;;J
H Time {10 Min Test TC Compatison TC Wwire Instrument TC MNumber For ot Instrument. o 5 F & i L i Accept |
TE”ED‘; Inkervals) Spoal T Mumber Correction Cortection | Temperature | Comparison I rt' Carrection Caa NdsTOr | pifference T ‘” el _F Reject
e Mumber Factor Factor Readings Check oieenon Factor onparton =R &,
Chexck. Furnace
3 12:00:00 &AM 1 a a a 4+ a a a a +-0 A
12:00:00 AM 2 o o o £l o o o o +/-0 A
High 12:00:00 &AM 3 o o o & o o o o +-0 A
*

Figure 76 - Report Properties Comparison Check window
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The information for the comparison check is generated from several of the Report Properties
fields.

Report Field Location in Tabs
Time Chart Start Time
Comparison Test T/C | Middle Left of Comparison
Spool Number Check
Comparison T/C Top Right of Comparison
Number Check
Comparison T/C Wire Top Right of Comparison
Correction Factor Check
Comparison
Instrument Correction Thermocouples
Factor
Comparison T/C Records the temperature
Temperature Readings of the Comparison T/C
Adjacent T/C Number Top Right of Comparison
for Comparison Check Check

. : Thermocouples, click View
Adjacent T/C Wire Offsets Used in Survey
button*
Thermocouples, click View
Offsets Used in Survey
button

Correction

Adjacent Instrument
Correction Factor

Adjacent T/C
Temperature Readings
for Comparison Check

Records the temperature
of Adjacent T/C

Difference Between

CC Difference Comparison T/C and
Adjacent T/C temperatures
Accept/Reject Criteria = | Set on Comparison Check
Tolerance of Furnace Page, Middle Right
Accept/Reject Dependent on A/R Criteria

Table 2 - Location of Report Fields

*The offsets for the T/C Wire Correction can be adjusted solely for the purpose of the

comparison by checking the box on the Comparison Check page labeled Use Custom Wire
Corrections.

A header text and a body text can be put in the report. There are Preview Report and Print
Report buttons in the top left hand corner of the Comparison Check page.
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The Chart Tab (Figure 77) contains the charted information from the time specified on the
survey. This tab is similar in design and function to the Real-Time chart (Figure 89). When the
chart tab is active, the chart toolbar buttons also appear and these buttons can be used to zoom
in on a section of the chart, pan the chart up, down, left or right, and refresh the chart back to
its original values. The screen will display 2 horizontal lines that represent the high and low
temperature tolerance levels based on the setpoint. This display will change based on the
tolerance level and setpoint defined in the Report Parameters. For more information about the
function of this screen, see the section “SDS = View Real-time Data.”

B Super Systems inc. SDS Reporter

Ele 305 Qptlons  Help

N EE SN o

==l

Report Propertiss ] Chart ] :wu]
DIZHZ006 120013 AN
Plot Walue - 00 -
| == k=] 3647
€ g
ETc ETEX 'Y 908 -
HArca | 3526
TC 6 2.4 oo -
FATc 6 6.5
HATcr 2501.9
HArcu 2601.9 €00 -
Tcy 2601.9
EATc 10 2501.9 00 —
Orc 11 s
Oreas e — = o = = =z i = = — =
EITC 14 | s ] e w_,w;b5~w-_;=;wﬂ=_‘.éw~_us%4WMn
Orcas | == Joe—
e -
E_‘f " 200 - N
O |
CI7C 20 | s 100 - | — — e L~
=
Orc 23 =
= i
O 100 -
O
) -200
a
COvc 2a | s
[ = T e L T T T T T T T T T
Krcar |~ | 700 M TASPM
— Time
[Suarvem Sha 453613 P [Survey End; 7:44.153 AM [Ervaation: 2,15 06 00

Fiqure 77 - Chart Tab

Note: checking or unchecking TCs on the Chart Tab will affect the Active TCs on the Report
Properties - Thermocouples tab.

The Data Tab (Figure 78) contains the data from each thermocouple for the each interval
selected from the Load Survey Data screen (Figure 59).

e inc. SDS Reporber

Ele 303 Options  Help
Repart Properties | chart | pacs |

SO SAepoter - Foady

Figqure 78 - Data Tab

Clicking on the “Round this data off to the nearest degree” link will pop up a message box
confirming the action (Figure 79). The rounding only affects imported data. The data in the
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logged files will still contain data rounded to one decimal place. Clicking on the “Yes” button
will round the data.

Round data to nearest degree? Xl

Are you sure ol wank ko round this daka ofF ko the nearest degree?

Mote: This will only modify Ehe imported data, the logged data Files will still contain daka to one decimal place.

no |

Fiqure 79 - Round data confirmation

File = Save / File = Save As / Save Button =

This will save any changes made to a new or existing report. If an existing file was opened, then
the software will automatically save the file without prompting. If a new file was created, then
the software will display a common Windows Save dialog box that will allow the user to save the
report to the “SDSReports” folder. Once the report has been saved to the “SDSReports” folder,
the software will automatically save the file the next time the save command is chosen.

Clicking the Save As menu option will automatically bring up the Save dialog box.

File 2 Export

There are four sub-menu options available for the export function:

Export Report to Word

Export Report to RTF

Export Survey Data to CSV

Export to Word - All
The Export Report to Word menu option will export the report to a Word document format,
which will provide more detail than the standard .rtf file format, if that option is desired. When
this menu option is clicked, the software will automatically begin to export the report selected
to a word document. Once the report has been exported, the new document will be displayed.
Note - no save djalog box will be displayed to the user. Initially, the report is saved as
“temp.doc” to the “C:\Temp” directory. The user can rename and save this report to any other
desired location. Note - any time this menu option is used, the resulting report will be saved as
‘temp.doc”, so any previous report that has not been re-saved will be lost. The Export Report to
RTFmenu option will export the report to a rich-text format (RTF). When this menu option is
clicked, the software will display a Windows Save dialog box that will save the .rtf file to the
“SDSReports” folder. The Export Survey Data to CSVmenu option will export all of the survey
data (as seen on the Data tab) to a comma-separated value format file. When this menu option
is clicked, the software will display a Windows Save dialog box that will save the .csv file to the
“SDSReports” folder. The Export to Word - All menu option will export all of the survey's
information to a Word file (report data, survey data, etc).

File 2 Print

This menu option is slightly different from the print button. There are five sub-menu options
available:

Print Report

Print Survey TC Data

Print Approach TC Data

Print All

Print Multiple Surveys
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The Print Report menu option will allow the user to print out a copy of the .SDSReport file. The
user will have to select the printer to print the report (Figure 80).

S 21
— Printer
MHame: Properties. .. I
Status: Feady
Type: Lexmark. Optra 5 2420
el here: LexmarkPS
Caomment: I Frint to file
— Print range Copies
= Al MHumber of copies: 1 =
£ Fages o Ee};
| Eemenla
£ Selection 2 3
Ok, I Cancel I

Figure 80 - Print prompt screen

The Print Survey TC Data menu option will print out a copy of the TC data (as seen on the Data

tab). The user will have the option to configure the page settings and select a printer to print to
(Figure 81).

Page Setup El El

Faper

Size:

Source: Auta Select -
Orientation kA argins [inchesz)

= Fortrait Le=ft: 0.5 Bight: |D.5

T Landzcape Top: o5 B ottarn: |EI. 5

Ok I Cancel | Frinter. .. |

Figqure 81 - Page Setup screen

The Print Approach TC Data menu option will allow the user to just print the approach datain a
tabular format. The Print All menu option will print all of the options - Report, Survey TC Data,
Approach TC Data - at once. The user will be able to select the printer (Figure 80). All three
options will be printed as separate reports.

Print Multiple Surveys

The SDS Reporter software will support the ability to print multiple setpoint survey reports.
Note - The software does not support multiple setpoint surveys. The multiple setpoint survey
report screen can be accessed by the File = Print — Print Multiple Surveys menu option. ANote
— When the screen is first displayed, the main SDS Reporter screen will be closed and any
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unsaved data will be lost. Any unsaved data will need to be saved before printing the multiple
setpoint survey report.

The Print Multiple Setpoint Survey screen will allow the user to select a report template that
utilizes the multiple setpoint survey tags (described below) and up to 5 survey files
(.SDSReport).

The search buttons -

J - next to each field
will allow the user to
select the specific Choose up to 5 surveys
report template or
survey file for the |
report. Survey #2 |C:"-_SSi"-_SDS"-.SDSHEpDrts"-.Open Hearth 1-25'-I}5'.S|
Once the report Survey #3 [C7\SSi\SDS\SDSReports\2-27-09.SDSReport |
]E_emplate and survey Survey #4 |C:"-_SSi"-.SDS"-.SDSHEpDrts"-.Open Hearth Cu:umplete-|
iles have been —_
selected, the user will Survey #5 | |

be able to export the
report to Word by
clicking on the Export Export to Word |
to Word button.

In order to view the
multiple setpoints on a Figure 82 - Print Multiple Setpoint Survey screen

™ print Multiple Setpoint Survey

Report Template: |C:"-.SSi"-.SDS"-.Hep-:urtTemplates"-.SampIe Repart TEI|

Survey #1 |C:"-_S SinSD5YSD5Reports Example Survey 505 H|

survey, the user will
need to use the {n} tag, where nis the survey number from the Print Multiple Setpoint Survey
screen (Figure 82). What the {n} tag does is tell the report to use the nth survey information for
all of the following tags until another {n} tag is found. Using the displayed screen as an
example, the following could be an excerpt from the template file:
{1} Survey #1 Duration: <SDS:DUR>
{2} Survey #2 Duration: <SDS:DUR>
{3} Survey #3 Duration: <SDS:DUR>

Setpoint: <SDS:S5P>

Max TC Value: #mtcv#
{4} Survey #4 Duration: <SDS:DUR>
This survey would display the durations for each of the survey files, and it would also display the
survey setpoint and max T/C value for survey #3. Notice that the normal data tags are still
used. The new tag only tells the software which survey to pull data from. MNote - For single
survey reports, the report template file does not need to be updated. f no {n} tag is used, the
software will default to the first survey file. On the actual report the {n} tag is invisible.
When the Print Multiple Setpoint Survey screen is closed down, the main SDS Reporter screen
will re-open.

Print Button %

When the user clicks on the Print button, the software will display the print preview screen,
which is similar in design and function to the print preview screen on the View Real-time chart
(Figure 90 or Figure 83 below]).
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File 2 Print Preview

The print preview screen is similar in design and function to the print preview screen on the
View Real-time chart (Figure 90) and is displayed here (Figure 83). See the section “Print
Button” under the SDS - View Real-time Data menu option for an explanation of the screen.
There are three sub-menu options available:

Print Preview Report

Print Preview Survey TC Data

Print Preview Approach TC Data

Each option will display a print preview of the desired report.

Eg Prinkt preview

EEEEELEL IR

Fiqure 83 - Print Preview screen

File 2 Exit
This menu option will exit the application.

SDS Menu Options

SDS 2 Manage Survey Templates

The Manage Survey Templates menu option will display the SDS Template Manager screen,
which will allow a user to add new templates and modify existing templates. See the section
SDS Template Manager Screen for a more detailed description of the functions of this screen.

SDS 2 Download Surveys and Data

The Download Surveys and Data menu option will allow the user to download surveys from a
specific SDS instrument. When the menu option is clicked, the SDS software will begin to
search for any and all data loggers located on the network (Figure 84).
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£ §DS Data Downloader g@@

File  Ophions
SDS: ([ 5 Touch S SN SDSOM

Searching for SOS...
Firighed searching. Found 1 505,

Download |

Fiqure 84 — SDS Data Log Extractor screen

Any data logger found on the network will be added to the drop-down list at the top of the
screen. If no devices are found, a message box will pop up letting the user know that no devices
were found on the network (Figure 85). Check the network connections to verify that any data
logger and computer are properly connected to the network.

SDSReporker x|

Mo S0S were Found, .,

Figure 85 - No SDS devices found box

Select the instrument from which to download the data files from the drop-down list box
labeled “SDS:". Under the Options menu, the Download menu option (Figure 86) will allow the
user to choose to download only data that has been used in surveys, or all of the logged data.
The SDS data logger will log data continuously when it is on regardless if a survey is running or
not. There will be a check mark next to the menu option selected. The default menu option is
Only data used in surveys. To download all data, make sure that A/l datais checked.

<= 5D5 Data Downloader, E“E|E|

Download, .. 3 v Only data used in surveys
——  After Downloading,., ¥ all data

Sear Ditive »
Firished searching. Found T 505,

Download |

Fiqure 86 - Download menu option

The After Downloading options do not apply to use with the Color SDS Data Logger.
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The SDS software will begin to download the survey data once the user has clicked on the
“Download” button (Figure 88]). The button will read “Abort” while the data files are
downloading.

If the user chose to only download data files used in surveys, and no data files are found, the
software will display an error message (Figure 87).

|
@ Mo survey records vweerse Found.,
=

Figure 87 - No survey records found box

The files will be downloaded to: SDS\(SDS Model number)\loglyear)—e.g.,
SDS\SDS505000\l0g2006.

> Data Downloader [ 64/127 1

SES: | J

Downloading File: dataloge. 434 to C:ASSINSDSASDSASD 5001 Wog201 24dataloge. 434 [1/15/2012 11:00:00 PM) -
Downloading File: datalogf. 434 ko CASSNSDENEDENVSDS00T Wag200 2hdatalogf. 434 [1/16/2012 12:00:00 &M]
Downloading File: datalogg. 434 to C:ASSINSDSASDSYSD 5001 Yog201 24datalogg. 434 [16/2012 1:00:00 Akd]
Downloading File: datalogh.434 to C:ASSIMSDSASDSNSD 5001 Mog201 24datalogh. 434 [1/16/2012 2:00:00 Ak]
Dawnlaading File: datalogi 434 ta CASSINSDSASDEAS D001 og201 24datalogi 434 [1/16/2012 3:00:00 AM]
Downloading File: datalog) 434 ta CASSINSDSYSDENS LS00 og201 24datalog) 434 [1/16/2012 4:00:00 &M]
Downloading File: datalogk. 434 to C:ASSIMSDSASDENSD 5001 Mog201 24datalogk. 434 [1/16/2012 5:00:00 Ak]
Dawnlaading File: datalogl. 434 ta CASSINSDSASDEASDS00140g201 24datalagl 434 [1416/201 2 £:00:00 AM]
Downloading File: datalogm. 434 to C:A551550 5550545050014 o201 2\datalogm. 434 [1/16/2012 7:00:00 Akd]
D ownloading File: datalogn. 434 to C:ASSMSDSASDSYSD 5001 Yog201 24hdatalogn. 434 [1/16/2012 8:00:00 AM]
Downloading File: datalogo.434 to C:ASS1MVSDSASDSEYSD 5001 Yog201 2hdatalogo. 434 [1./16/2012 3:00:00 Akd]
Downloading File: datalogp.4:34 to CASSINSDSASDENSDE00T Mog201 24datalogp. 434 [1/16/2012 10:00:00 &M

| Abort

Figure 88 - SDS Data Log Extractor progress

The software will display a continuous progress of the download status (see Figure 88). Note:

since there may a large number of files to download, this process may take several minutes to
complete.

When all of the files have been downloaded, the words “Operation Complete” will be at the
bottom of the list, and the button at the bottom will read “Download”. A message box will also
be displayed reading “Operation Complete”. Clicking on the OK button on the message box will
close down the download data screen.

Clicking on the “Abort” button will stop the download and close the SDS Data Log Extractor
screen. Any files that have already been downloaded will not be erased. The next time the user
wishes to download survey data from the same device, the files that have already been
downloaded will be skipped and not be downloaded again.

SDS 2 Launch Direct FTP
The Launch Direct FTP option does not apply to the Color SDS Data Logger.
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SDS 2 View Real-time Data
< Current Trends - 192.168.1.214 9=

i A M .
(:h fkll R |?| o | | [ Override Tolarance
a Data
Plot | value |~ SDS B020/3040
FTCc1 23718 2200 —
o] 3
[FTCc3 23718 2000
TC 4 2371.9 =
ETcs 23719
FITC6 23718 as0d. -
MTCc?T 23718 E
FlTce 237189 1600 =
FlTces 23719 3
FTC 10 23719 1400 =
M TC11 23719 3
FTC12 23719 1200 =
FTC13 23719 3
[FTC14 23719 E
FITC15 23719 g
ElTC16 13
FCAT | 1.3 8002
E
6003
FTC20 1.4 3
400=
E
TC23 0 3
2003
E
L B R R T T EEREEER R T T T
12:15 PM 12:30 PM 12:45 PM 1:00 PM 1:15 PM
™ b Time
MNext update: 1 seconds.

Figure 89 — Real-time Data screen

The View Real-time Data menu option will display the most current real-time data available.
This screen will update itself with the most current real-time data every 60 seconds. The
amount of time left until the next update will be displayed in the bottom left-hand corner of the
screen. When it does update, the software will connect to the SDS, download the data, and re-
draw the screen. Any screen settings, such as the size of the graph and how zoomed in the user
is, will not be changed. Note: If the Multiple SDS Mode menu option is checked, then the SDS
software will display a device selection box that will allow the user to choose which device to
gather the real-time data from. If the Multiple SDS Mode menu option is not checked, then the
SDS software will gather real-time data from the first SDS device that it finds on the network.
Note: it is possible to view real-time data from more than one SDS instrument at a time. To
view multiple real-time data, click on the View Real-time data menu option again and select the
next SDS instrument. The Chart tab will display the real-time data as a graph, along with the
tolerance, displayed as 2 blue lines. The Data tab will display the real-time data in numerical
form. On the Chart tab, all of the buttons are available. On the Data tab, only the Print button is
available.

* Cursor Button
This is the default cursor used on the screen. The user can select the various TCs to plot and
move the scrollbar on the left side of the screen up or down in order to see more TCs.
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&K Zoom Button

This will allow the user to zoom in the graph of the real-time data. Once the cursor is over the
graph it will change to a crosshair, +. The user can then hold down the left mouse button and
drag the cursor to highlight the section of the graph that is to be enlarged. Letting go of the
mouse button will enlarge the graph.

@ Pan Button

This will allow the user to pan to a different part of the graph. Once the cursor is over the

graph, it will change to a crosshair with arrows: & By holding down the left mouse button
and moving the mouse left, right, up, or down, the user can move the scale of the graph by
minutes or temperature, or both.

‘D Refresh Button

This will refresh the graph and reset the graph’s display values to their default values. For the
values along the y-axis, the refresh sets the range from 0 to 2400. For the minutes along the x-
axis, the refresh encompasses approximately two hours. Note: when the Real-time screen first
loads up, the graph encompasses roughly one hour of data. The graph is marked with fifteen-
minute intervals along the x-axis.

& Print Button
This will create a print preview of the graph for printing purposes. When the user clicks on the
Print button, the Print Preview screen will be displayed (Figure 90).
ﬂgPrint preview ;Iglil
%Q'|Eﬂmn| Page I 1::1

ETTTINTE
ARRiARARAR AR

T
T< 1
1=
=

RITLEREEERE IR S

Figure 90 - Print Preview screen

From the Print Preview screen, the user can choose to zoom in on the preview by pre-defined
percentages (10% - 500%) or leave the zoom on the default setting (auto). The user can also
determine how many pages to view at once (one, two, three, four or six). The default is one
page. The upper right-hand corner of the Print Preview screen contains a page counter, which
will allow the user to select which page to preview. Clicking on the “Close” button will close the
Print Preview screen without printing the chart. Clicking on the Print button (&) will print the
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document. Note: the Zoom function is for preview purposes only and will not affect the actual
print size. Once the document has been printed, the user can close the Print Preview screen.

H Real-time button
This button will allow the user to keep the cursor in a real-time mode, which will automatically
update the TC values on the left of the screen after every update. Clicking on this button will
start the real-time mode. Clicking on this button a second time will take the screen out of real-
time mode. Note - The graph will still continue to update once a minute, but the values on the
left will no longer be up-to-the-minute accurate.
The checkboxes under the “Plot” section will allow the user to determine which TCs to plot on
the graph. Checking a specific TC will display that TC’s data on the graph. The data under the
“Value” section is the current temperature of the TC. Note: even if the Pan button or the Zoom
button has been selected, the user can still select or de-select the TCs. This will not affect the
zoom status or the pan status.
The “Override Tolerance” checkbox will allow the user to override the tolerance that is set up
for the report. Note — This does not change the actual tolerance on the survey report, only on
the real-time screen. Once checked, the user will be able to select a setpoint and a new
tolerance. The tolerance bars on the graph will also update with these changes.

Iv¥ Owerride Tolerance Setpoint: [ 3: Tolerance: (g 5

SDS 2 Manage Survey Records
51

Local Survey Records | Remote SDS Survey Records I

{SDS001)

M Default changed: [company m - id m]
Defzult Template: (SDS001)

Default Template: {5Ds001)
PM - &:17 RM Default Template: {SDS001)
Mote: Hold shift or control to select multiple records.
Delete |

Figure 91 - Manage Survey Records — Local Survey Records Tab

The Manage Survey Records screen will allow the operator to delete survey records from the
survey database file either locally on the computer or remotely on the SDS data logger. The
“Local Survey Records” tab (Figure 91) will work with survey records saved locally to the
computer. To select multiple sequential records, hold down the Shift key and click on the
desired survey records. To select non-sequential records, hold down the Ctrl key and click on
the desired survey records. The operator will have to confirm the deletion by clicking on the
“Yes” button on the message box (Figure 92).
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Delete local records? x|

"-I Are you sure you want to delete the selected records from the
¥' local database?

Figure 92 - Confirm deletion of local records

= Manage Survey Records ;lglil

Local Survey Records Remote S05 Survey Records I

Sure Records |[1 52.168.1.130] 5D5 Touch Screen SN SD5001

Found 2Z SDS ocn the Network

Mote: Hold shift or contrel to select multiple records.

Figure 93 - Remote SDS Survey Records Tab

The “Remote SDS Survey Records” tab (Figure 93) will allow the operator to delete survey
records directly from the SDS data logger. The drop-down list at the top of the screen will list
all of the SDS data loggers found on the network.

Note: The drop-down list may take a few moments to search the network for SDS data loggers.

Note: Currently, the drop-down list will also be populated with Video Recorder data loggers.
Please use caution when selecting a data logger from the list; deleting data from a Video
Recorder could produce undesirable consequences. When the operator has selected the
correct data logger, he/she can click on the “Load” button to load the survey data. To select
multiple sequential records, hold down the Shift key and click on the desired records. To select
multiple non-sequential records, hold down the Ctrl key and click on the desired records.
Clicking on the “Delete” button will remove the survey records from the list. Note - The survey
records will be removed from the list, but not actually deleted from the SDS data logger until
the “Save Changes” button has been clicked. If one or more survey record is accidentally
deleted, click on the "X in the top right of the screen to close the screen down, and start over.
Clicking on the “Save Changes” button will save the changes back to the SDS data logger. No
confirmation is needed for this action. Once the changes have been saved, a message box will
be displayed (Figure 94).
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Saved. E|

\11) Your changes have been saved.

Figure 94 - Changes Saved message box

SDS 2 Perform Comms Test

The Perform Comms Test menu option will send out a broadcast over the network to determine
if any SDS instruments are located on the network. If an instrument is located on the network,
the software will attempt to ping the device. This function will let the user know if
communication with an SDS instrument through the SDS Reporter software is possible. When
the test has finished, one of three options will happen:

1. No SDS found

No SDS instruments were found on the network. Check the network connections. A
message will be displayed to the user (Figure 95). Click the “OK” button to close the form

Testing Communications... =l

Testing Communications - Please Wait...

Cluerying Metwark for SDS..

Mo SDS Found =

@ Could mok Find any SOS on Ehe nekbwork

Figure 95 - No SDS found on network message

2. One or more SDS were found.

One or more SDS instruments were found on the network, and all responded to the ping.
A message will be displayed (Figure 96).

|

@ 2 53DS Found. Communcaktions tesk(s) successhul,

Fiqure 96 - Communications OK message

This means that all communications appear to be ok (Figure 97). Click the “Close”
button to close the form.
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Testing Communicakions.. =1

Testing Communications - Please Wait...

| - |
Cluerying Metwork for SDS ..
Found SDS at IFP: 192.168.1.202 | attempting to ping it.
The SDS replied to ping successfully [0 mzec)
Found SDS at IF: 132.168.1.207 | attempting to ping it.
The SD5 replied to ping successfully [0 mzed]
|

Close I

Fiqure 97 - Communications OK message on Test Comms dialog box

3. One or more SDS were found, but one or more failed to respond to a ping.

SDS instruments were found on the network, but one or more did not respond to a ping.
For each instrument that does not successfully respond to the ping, the user will be
informed that there was a problem testing the communications and the software will
give the IP address of the SDS instrument(s) that failed to respond as well as the IP
address of the SDS instrument(s) that did respond successfully to the ping (Figure 98).
The most common cause is different subnets between the SDS and the computer (Figure
99). The user may need to change the IP address of the SDS through menu option 26,
Set IP Address. Click the “Close” button to close the form

Testing Communications.. |

Testing Communications - Please wWait...

=]
Querying Mebwork for SDOS .
Found SDS at IP: 132.168.0.202 . attempting to ping it.
The SD5 did not reply to a ping.. Check your network configuration]

Close I

Figure 98 - One or more SDS did not respond message on Test Comms dialog box

Communications Problem Detected. x|

The 305 ak IP 192,165.0,202 Failed to respond bo a ping request, The most common cause is that the computer and
505 are on different subnets, Please check to make sure the IP address of the SDS is compatible with this cormputer,

Figure 99 - One or more SDS did not respond message

If the user is attempting to communicate with the SDS directly using a laptop that also
has a wireless network on it, the wireless network could interfere with some of the SDS
Reporter functions. The UDP error could happen if the user tried to ping a data logger
while a wireless network was enabled (Figure 100). Any wireless network should be
disabled before running the SDS Reporter software.
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SDSReporter @

The UDP Broadcast timed out,

The miost comman cause For this is having a wireless network connection enabled while being connecked ko the 503, Please go to control panel - = Metwork
Connections, and right click - disable any wireless network connections.,

Another possible cause is firewall f antivirus software preventing the communications.,

Figqure 100 - UDP Error

Options Menu Options

Options 2 Multiple SDS Mode

This is a toggle switch for the application. If there are multiple SDS instruments located on the
network, click this menu option. Once clicked, there will be a check mark next to the menu
item. If this menu option is not checked and there are multiple SDS instruments on the
network, the software will use the first SDS device that is found. This menu option is checked
by default.

Options 2 Show Labels On Chart

This is a toggle switch for the application. When checked, this will display the “Begin Survey”
label for the survey on the real-time graph (Figure 101).

Begin Survey

Figure 101 - Label from real-time graph

Options 2 Color Screen Scanning
This is a toggle switch for the application. This option must be checked in order for SDS

Reporter to scan for the Color SDS Data Logger. This scanning will take place over Ethernet and
over USB using ActiveSync (Windows XP) or Mobile Device Center (Windows Vista/7).

Help Menu Options

Help 2 Check for Updates

The Check for Updates menu option will check for updates over the Internet and automatically
update the SDS firmware and software. If an update is found, the software will display a

message box asking the user for update confirmation [F|gure 102).
SDSReporter Automatic Updaktes E; ﬂ

@ An update is available. Would you like to install it now?

no |

Figure 102 - Update found message box
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The software will automatically update the files and restart the application (Figure 103)

ES¢ Automatic ‘

@. Autolpgrade is upgrading local application files.

Downloading AxInterop. CWIUJIControlsLib. dll

Cancel I

Figure 103 - Automatic Update screen

If no updates are available, then the software will display a message box informing the user
(Figure 104).

SDSReporter Automatic Upda x|

@ Mo updates are available at this time.

Figure 104 - No updates message box

Help 2 About

The About menu option displays the SDS Reporter version that is running, and all of the
previous versions with any version notes (Figure 105).

About 5D5Re porter,

Application Yerzion: 1.101.1.164
Patch Motes

Software Product SDSReporter ~

ersion 1.101.1.164

Date: 1041912
Furnace Range iz now string in color zds surveys databasze.

Wersion 1.101.1.163

Clate: 9414412
Contains data tag for individual comection factors, They are Hof1# where 1 iz the TC number.

ersion 1.101.1.162

Dlate: 9414412
Added ability to add corection factors for individual TCe. Saving those i pazscode protected. Uniformity
Seltings iz paszcode protected,

ersion 1.101.1.161

Date: 3/6/12
‘wihen downloading survey for first time in monochrome sds, should download corect data. There waz a
bug where would have to download baice.

ersion 1.101.1.160

Dlate: 8413412
‘when catching the socket imeout exception when gcanning for 505z, no longer reliez on parsing
exception sting to determine tppe of exception, w

Cloze

Figure 105 - SDSReporter About box
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SDS Data Tags

SDS Data tags are created so that all of the template information and survey data can
automatically be used for the report process. Data that is captured during the survey is
summarized to provide the overall results for the report. This can be in the form of a graph,
tabular data, text, etc. Data tags have been specifically created to address the uniformity
requirements for AMS and other standards. We have tags that address overshoot, minimum TC
with value, maximum TC with value, trend data, tabular data, etc. An example of an output from
the data tags can be seen by opening the Example report from the SDS Reporter provided with
the installation. The only data not generated from data tags is the tabular print out of the actual
temperatures. This data is generated from the Survey 7C Data option and will print all data
points that are displayed on the graph between the “start” and “stop” selected by the user in the
survey.

In the figure below (Output From Data Tags), you can see an example of the data tags for the
graph, survey setpoint, minimum and maximum TCs with values and deviation. The data tags
used to generate the information below are:

<SDS:GRAPH600x400>

TC Survey Summary
Minimum TC number: #mtcn# Maximum TC number: #xtcn#
Minimum TC Value: #mtcv# Maximum TC Value: #xtcv#
Min deviation from setpoint: #md# Max deviation from setpoint: #xd#
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Tag
SDS:FILE

SDS:PD
SDS:PT
SDS:FID
SDS:FM
SDS:FT
SDS:FU
SDS:FD
SDS:FC
SDS:FOR
SDS:SD
SDS:ST
SDS:SDR
SDS:DUR
SDS:0P
SDS:APP
SDS:TITLE

Super Systems Inc.

TC Trend Data

AN
] AT
AR

by

| N .
§ ol b |I 1 L 4
\ I LII\ r"‘"\ AR NN
':f.l’ r'\s':\"i.\":- i.'\\':-,_ Y TR
RN

TC Survey Summary

| Minimum TC number: 6
Minimum TC Value: 77.8

Maximum TC number: 3
Maximum TC Value: 418.7

Min deviation from setpoint; -272.2

Max deviation from setpoint:. 68.7

Figure 106 - Output from Data 7ags

Description

The filename the report is saved as
The current date when the report is printed

The current time when the report is printed

The furnace ID

Furnace make/model
Furnace type

Furnace use

Furnace dimensions
Furnace Class

Furnace operating range
Survey date

Survey time

Survey date range

Duration of the survey

Operator. Survey performed by

Survey approved by

The heading, or title, of the report

Color Touch Screen Data

Usage
<SDS:FILE>

<SDS:PD>
<SDS:PT>
<SDS:FID>
<SDS:FM>
<SDS:FT>
<SDS:FU>
<SDS:FD>
<SDS:FC>
<SDS:FOR>
<SDS:SD>
<SDS:ST»>
<SDS:SDR>
<SDS:DUR>
<SDS:0P>
<SDS:APP>
<SDS:TITLE>
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Tag
SDS:NOTE
SDS:TOL
SDS:0TS
SDS:SP
SDS:TCN
SDS:TCT
SDS:TCS
SDS:TCC
SDS:TCCD
SDS:TCCF
SDS:SDN
SDS:SDSM
SDS:SDSS
SDS:SDSC
SDS:SDSCD
SDS:SDSCF
SDS:SPEC
SDS:INT
SDS:T
SDS:SIM
SDS:0VS
SDS:MIC
SDS:RES
SDS:GRAPH400x400
SDS:COM
SDS:UDUR
SDS:UTCN
SDS:PCT
SDS:PDB
SDS:POL
SDS:PPB
SDS:PR

Super Systems Inc.

Description
Notes for the survey

Survey tolerance / uniformity required
Overtemp setpoint

Survey setpoint

Number of thermocouples
Thermocouple type

Thermocouple spool number
Thermocouple calibrated by
Thermocouple calibration date
Thermocouple spool correction factor
Next survey due date

Survey box make/model

Survey box serial number

Survey box calibrated by

Survey box calibration date

Survey box correction factor
Specifications the survey meets
Sample interval

Temperature character - For C
Simulate load, in pounds

Overshoot (Deprecated)

Microns

Survey result

Inserts a 600X400 image of the graph
Company name

User defined survey duration

User defined number of thermocouples
PID cycle time

PID dead band

PID output limit

PID PB (gain)

PID rate

Usage
<SDS:NOTE>

<SDS:TOL>
<SDS:0TS>
<SDS:SP>
<SDS:TCN>
<SDS:TCT>
<SDS:TCS»>
<SDS:TCC>
<SDS:TCCD>
<SDS:TCCF>
<SDS:SDN>
<SDS:SDSM>
<SDS:SDSS»>
<SDS:SDSC»>
<SDS:SDSCD>
<SDS:SDSCF»>
<SDS:SPEC>
<SDS:INT>
<SDS:T>
<SDS:SIM>
<SDS:0VS»>
<SDS:MIC>
<SDS:RES>
<SDS:GRAPH600x400>
<SDS:COM>
<SDS:UDUR>
<SDS:UTCN>
<SDS:PCT>
<SDS:PDB>
<SDS:POL>
<SDS:PPB>
<SDS:PR>
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Tag Description Usage

SDS:PRE PID reset <SDS:PRE>
SDS:CMF Temperature controller manufacturer <SDS:CMF>
SDS:CMA Temperature controller make/model <SDS:CMA>
SDS:IT Controller instrument type <SDS:IT>
SDS:TCG Thermocouple gauge <SDS:TCG>
SDS:0V Overshoot - yes or no <SDS:0V>
SDS:0D Outputs TC and temp if overshoot occurred <5DS:0D>
SDS:0VT Time the overshoot occurred <SDS:0VT>
SDS:CTD Inserts a note regarding the control <SDS:CTD»>

Thermocouple. Inserts nothing if no control
Thermocouple was chosen

SDS:CTN Control thermocouple. Inserts “None” if <SDS:CTN>

°#
SDS:ED
SDS:ET
SDS:TCM
SDS:UD1
SDS:UD2
SDS:UD3
SDS:UD4
SDS:UD5
SDS:UDé6
SDS:UD7
SDS:UD8
SDS:UD9
SDS:UD10
SDS:UD11
SDS:UD12
SDS:UD13
SDS:UD14
SDS:UD15

Super Systems Inc.

None is defined
°degree type
Survey end date

Survey end time

Thermocouple map (image)

User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field
User defined field

1

O 00O NN o6~ o A oLON

N N O
g N W N - O

°#
<SDS:ED>
<SDS:ET>
<SDS:TCM>
<SDS:UD1>
<SDS:UD2>
<SDS:UD3>
<SDS:UD4>
<SDS:UD5>
<SDS:UDé6>
<SDS:UD7>
<SDS:UD8>
<SDS:UD9>
<SDS:UD10>
<SDS:UD11>
<SDS:UD12>
<SDS:UD13>
<SDS:UD14>
<SDS:UD15>
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Tag Description Usage

SDS:UD16 User defined field 16 <SDS:UD16>
SDS:UD17 User defined field 17 <SDS:UD17>
SDS:UD18 User defined field 18 <SDS:UD18>
SDS:UD19 User defined field 19 <SDS:UD19>
SDS:UD20 User defined field 20 <SDS:UD20>

*** Survey scope data tags - {n} where nis the survey number - are used to display survey
information for the multiple survey report feature. See the section Print Multiple Surveys for
more information on how to use these data tags ***

Sample Output

Tag Sample Output
SDS:FILE SDSReport1.sdsreport
SDS:PD 2/16/06

SDS:PT 11:30:00 AM
SDS:FID Batch 1

SDS:FM Furnace Mfg.
SDS:FT Batch Gas Draw
SDS:FU Temper

SDS:FD 24 x15x 12
SDS:FC A

SDS:FOR 650 - 1000°C
SDS:SD 2/16/06

SDS:ST 11:30:00 AM
SDS:SDR 2/13 THRU 2/14
SDS:DUR 00:30:00

SDS:0P Shaun Scott
SDS:APP Scott Brown
SDS:TITLE Test Survey 1
SDS:NOTE This is a test survey
SDS:TOL [+/-]110

SDS:0TS +10

SDS:SP 750
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Tag
SDS:TCN

SDS:TCT
SDS:TCS
SDS:TCC
SDS:TCCD
SDS:TCCF
SDS:SDN
SDS:SDSM
SDS:SDSS
SDS:SDSC
SDS:SDSCD
SDS:SDSCF
SDS:SPEC
SDS:INT
SDS:T
SDS:SIM
SDS:0VS
SDS:MIC
SDS:RES
SDS:GRAPH600x400
SDS:COM
SDS:UDUR
SDS:UTCN
SDS:PCT
SDS:PDB
SDS:POL
SDS:PPB
SDS:PR
SDS:PRE
SDS:CMF
SDS:CMA
SDS:IT

Super Systems Inc.

Sample Output

20

K

2458

Soandso

1/15/06

-1

2/28/06
SSISDS8120
SDS60293201
Super Systems Inc
1/15/12

-1.0

AMS 2750-D and E
10s

F

500

None

N/A

Passed

[An image of the graph]
Company Name

30 mins

20

20

N N NN NN DN

Super Systems
7EK
B
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Tag
SDS:TCG

SDS:0V
SDS:0D
SDS:0VT
SDS:CTD

SDS:CTN
°#
SDS:ED
SDS:ET
SDS:TCM

TC Offsets

Tag
#Hol#

#Hef1#

Tag
#Hol#

Sample Output
16

Yes

TC6 - 1700°
5:30

TC5 is the control TC, and is not used in uniformity survey
results

TC5

°F

2/16/06

11:30:00 AM

[Thermocouple image]

Description Usage
Offset for TC1 #ol#
Individual correction factor for TC1 #cf1#

Sample Output
-1

Min/Max/Mean/Spread/Deviation

Tag
#n1#

H#x1#
#m1#
#Hs1#
#vn1#

#vx1#

Super Systems Inc.

Description Usage
Minimum temp for TC1 within the selected #n1#

Survey region. Substitute numbers for other

TCs

Max temp for TC1 H#x1H#
Mean temp for TC1 Hm1#
Spread for TC1 Hs1H#
Deviation (@min temp from setpoint

for TC1 #vn1#
Deviation ([@max temp from setpoint

for TC1 Hvx1#
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Tag
#vm1#

#mtcn#
#mtan#

#mtav#

#mtcv#
#mtcex#

#md#

H#Hrect#

#xten#
#xtan#

#xtav#

#xtcm#

#xtcv#
#xd#

Tag
#n1#

Hx1#
Hm1#
Hs1#

Super Systems Inc.

Description
Deviation ([@mean temp from setpoint for

TC1

Minimum TC number

Minimum TC number during approach
segment

Minimum TC value during approach
segment

Minimum TC value

The maximum temperature of the
minimum TC

Minimum calculated survey TC absolute
deviation from setpoint

Recovery Time - the time between the
when the first TC comes into tolerance
the time when the last TC comes into
tolerance

Maximum TC number

Maximum TC number during approach
segment

Maximum TC value during approach
segment

Minimum temperature of the maximum
TC

Maximum TC value

Maximum calculated survey TC absolute

deviation from setpoint

Sample Output

183
183
183
12.5

Usage
#vm1#

#mtcn#
#mtan#

#mtav#

#mtcv#
#mtcex#

#md#

H#Hrect#

#xten#
#xtan#

H#xtav#

#xtcm#

#xtcv#
#xd#
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Tag Sample Output

#vn1# 383
Hvx1# 383
#vm1# 383
#mtcn# 2
#mtan# 2
#mtav# 150
H#mtcv# 1
#mtcx# 500
#md# 201.0
Hrect# 3 mins 30 secs
#xtcn# 1
#xtan# 6
#xtav# 1500
#xtecm# 500
Hxtcv# 183
H#xd# 383.0
His# 13.8

Creating a Personalized Template

To create a personalized template, the user needs to open a document in WordPad and save it
to the “ReportTemplates” folder in the main installed folder as a Rich Text Format (.rtf] file. Any
of the SDS data tags listed in the above section can be used to create a company-specific
template. For example, suppose that someone wanted to create a simple template called
“NewTemplate” which displays the current date and time the report is printed, the company
name, the title of the report, the number of thermocouples used, and the results of the survey.
First, the user would open WordPad and save the file as “NewTemplate.rtf” in the
“ReportTemplates” folder in the main installed folder. Next, the user would set up any initial
formatting settings, such as margin sizes, page layout (portrait or landscape), etc. Now, the
user can set up the template to his or her company’s specifications. Suppose that the current
date and time will be in the top right corner of the report and should be 10-point Arial font. On
the first line, the user can select the right-justified option, the 10-point font size option, and the
Arial font option. This will leave the cursor in the top right corner. Next, the user will enter the
following exactly (including the brackets): <SDS:PD>. This will be where the current date is
displayed. On the next line, the user can enter <SDS:PT>. This will be where the current time is
displayed. Now suppose the title of the report should be centered, bold, 14-point Arial font. The
user will select the center-justified option, and the 14-point font size option. This will place the
cursor in the middle of the line. The user will then enter <SDS:TITLE>. The rest of the report -
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company name, number of thermocouples used, and the results of the survey - can be left-
justified, non-bold, 12-point font. On the next line, the user will select the left-justified option,
the 12-point font size option, and deselect the bold option. The user can then enter: Company
name: <SDS:COM>. On the next line the user can enter: Number of thermocouples used:
<SDS:TCN>. On the next line, the user will enter: Survey results: <SDS:RES>. Next, make sure
the document is saved and close the document out. Note: it is always good practice to save a

document in progress often in case of power failure. The resulting template should resemble
Figure 107 below.

NewTemplate - WordPad

File*iEdit  View Insert Farmat Help

el Sk & @ B
Avial v | (14 | |westemn v B[ u B =
5 ------ T FE T 7

«505:PD=
<ED3:PT=
<SDS:TITLE>
Company name: <505 COM=
Mumber of thermocouples used: <SDSTCN=
Survey results: <SDSRES=

Figure 107 - Completed NewTemplate report template (saved as an RTF file in WordPad)

Next, the user will select the report template to use from the SDSReporter application’s Open

option. Clicking on the Open button, —I , next to the Report Template field will allow the user
to choose which report template to use (Figure 58). The user can choose the NewTemplate.rtf
file. Next, the user will choose the “Export to RTF” print menu option on the File menu and
choose the location to save the .rtf file. The actual report should resemble Figure 108 below.

02/21/08 o
3:57 A

Test Report - Tim Kell
Company name: SSi
Number of thermocouples used: 16
Survey results: Passed

Figure 108 - Actual NewTemplate report
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SDS Template Manager

The purpose of a template is to save the user’s time by filling in some of the more generic
survey data. For example, the user could create a template for one customer, including
company name, TC type, etc; then when the survey is run using this template, this information is
already present and it won't need to be entered for each survey run for that customer. The new
SDS Template Manager (Figure 109) allows the user to see all of the templates currently stored
on the SDS instrument, as well as any templates saved to a local computer. The Template
Manager also allows the user to create new templates and save them to a local file on a
computer or network, or to the SDS instrument.

£2» SPS Template Manager
File

RRI=1N" |
<New Template>

Templates

Add Template

£

Figure 109 - New SDS Template Manager

Description/Function of Template Manager Screen buttons/menu options

This section will describe the function of the toolbar buttons and menu options for the Template
Manager Screen. Clicking on either the form button or the menu option will produce the same
result, so each pair of button/menu option will be explained in this section.

New Button / File » New

The New button, —1 , or New menu option will allow the user to create a new set of templates. The
maximum number of templates that can be added per file is 32. Note: initially, there are no templates in
the file.

Open Button / File » Open

The Open button, j or the Open menu option will allow the user to open an existing template
file either from the local computer, or from an SDS instrument on the network (Figure 110).
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= Open Template File

f* Open a lozal survey template file located on my computer
Local File

|E:\SSi\SDS\Suwe_l,lTempIates\Test.t:-ct Browsze

" Open a remote survey template file located on an SOS instrurment

Remote [SDS)
Select Instrument:

192 168.1.219 SSI td odel SDSSD2D [ atalogger SM 5050807116
2171551 Model SD58020 Datalogger SW SDS0807115

[192188121 6] SSI todel SDSBD2D Datalogger SH SDS0807113

Scan
Cancel Open File |

Figure 110 - Open template menu option

The use will be able to open a local template file or a template file that is on an SDS. If the user
selects a local file, the user will be able to click on the Browse button to select the file to open.
The SDS software will display a common Windows dialog box for the user to select which file to
open. If the user selects an SDS instrument, the SDS Software will display a selection box with
all of the available SDS instruments on the network. Note: Since the SDS software is searching
the network for all SDS devices, it may take a couple of minutes for the selection box to be
displayed. This list will be populated with all of the available SDS devices found when the “Open
Template File” screen is first opened. Clicking on the Scan button will allow the user to re-scan
the network for available SDS instruments. Once a local or remote file has been selected, click
on the Open File button to open the file, or click on the Cancel button to close down the screen
without opening a file. Note: When the Open Button or the Open menu option is clicked, the tabs
that contain all of the fields for the template will not become visible - an individual template
must be selected to view the tabs. Once the file has been loaded, the filename will be listed
above the Templates list on the left of the form (Figure 109).

Save Buttons / File » Save

The Save button, H, or Save menu option will allow the user to save the current file back to
the local machine or the SDS instrument. Note: Any changes made to any template will be
saved at once when this option is selected. Note: If the user is working with a new template file,
the Save function will act like the Save As function (see below section).

File 2 Save As

This option acts the same way as the Save option, only it will display a dialog box that will allow
the user to select the file to save (Figure 111). This functionality of this screen is similar to the
Open Template screen (Figure 110). The template file can be saved locally on a computer or
remotely on an SDS instrument. If the user selects to save the file locally, the user will be able
to click on the Browse button, which will display a common Windows save dialog box. The user
will be able to select the location and give the template file a name. If the user selects to save
the file to a remote SDS, the software will display a selection box with all of the available SDS
instruments on the network. Note: Since the SDS software is searching the network for all SDS
devices, it may take a couple of minutes for the selection box to be displayed. This list will be
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populated with all of the available SDS devices found when the “Save Template File As” screen
is first opened. Clicking on the Scan button will allow the user to re-scan the network for
available SDS instruments. Once a local file or remote file has been selected, click on the Save
File button to save the file, or click on the Cancel button to close down the screen without saving
the file.

[ save Template File As...

+ Save a survey template file on the local computer

Local File

L4555 D545 urveyT emplatesh Templates. bt Browse

" Save a remate survey template file to an 505 instrument

Remote [S0S)
Select Instrument;

192.168.1.217] 551 Model SD58020 D atalogger SH SDS0807115
[192.168.1.216] 55| Model SD58020 D atalogger SH 5050907119
[192.168.1.219] 55| Model SD58020 Datalogger SM 5050207116

Scan
Cancel Save File

Figure 111 - Save Template File As... screen

The software will always display a message box with the success or failure of the save.

Exit Button / File » Exit

This option will close the Template Manager screen.

Add Template Button

This option will add a template to the collection of templates stored in memory, up to 32 total templates.
The only required field is the Template Name. The default template name is <Template Name>

Once a template has been added, the new template will be loaded into the fields.

Delete Button
This option will delete a template from the collection of 32 templates stored in memory.

Copy Button

This button will copy a template into the collection, assuming there are less than 32 templates
already. This would be useful if the user only wanted to change one or two items on the
template, such as the setpoint.

Arrow Buttons

The arrow buttons next to the Copy button will allow the user to change the order of the
templates in the file. This way, the more commonly used templates can be kept at the top of the
file so the user will not have to scroll down to see the template on the SDS. The up arrow
button will move the template up one position, and the down arrow button will move the
template down one position.
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Description of Template Manager Screen Tabs

Template Information Tab

2 5DS Template Manager
File

NEE

<New Template>

~Templates Default
Add Template | L En
TemD|atE|nf0fmali0n]Suweylnformation ActiveTCs Eontrollerlnformation]

Template Name: ]Default

Company Mame; |S uper Systems

[ Furnace Information

Fumnace ID: |Eatch #1 Temp Type: £

Range: W
SN TR e L
Dimensions: T 1Batch—‘

Furnace Class: 4

Make/Model, |Fumace Mig.

Notes: lThis iz the default template

|T|
Delete | Copy |J

Figure 112 - Template Information tab

This tab contains general information about the template such as the Template Name, the Company
Name, furnace information such as the furnace ID, the make and model of the furnace, the furnace
dimensions, the temperature type (Fahrenheit or Celsius), the temperature range, the furnace type, the
furnace use, the furnace class, and any Notes about the template. See “Description of Template Manager
Screen Fields” for the maximum number of characters allowed per field.
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Survey Information Tab

2 5DS Template Manager

Filz

NEE

ASDF.ixt @ C:\SSi\SDS\SurveyTemplates

~Templates Default
Add Template | L En
Template Information  Survey Information ]ActiveTEs] Eontrollerlnformation]
1 Survey Information
Survey Duration: 0 Minutes Setpaint: 500

Survey Tolerance: [+ [10 O WK—
Simulsted Load (bst 1720 Specilication: [AM5 2750 D

|T|
Delete | Copy |4¢,l

Figure 113 - Survey Information tab

This tab contains information about the survey such as the Survey Duration in minutes, the Survey
setpoint, The survey Tolerance, the Operator performing the survey, the simulated load, in pounds, and

the Specification the survey meets.
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Active TCs Tab

2 5DS Template Manager
Filz

MEIE
ASDF.ixt @ C:\SSi\SDS\SurveyTemplates

~Templates

Add Template | m

Templatelnformation] Survey Information  ActiveTCs ] Controller Information]

i Thermocouples

Mumber of TCs: ]10— TC Gauge: ’ES—
TC Type: ]K_‘
1L Spaol SM: 1234
TC Spool Comection: 2

[ Active Inputs

W Usze these active TC setlings

vl Input 3 ~
Il Input 4

vl Input 5

Il Input B

Iwl Input 7

vl Input 8

| Input 9

&2 input 10 |

| Input 11 B

|T|
Delete | Copy |4¢,l

Figure 114 - Active TCs Tab

This tab contains information about the active TCs such as the number of TCs used, the Gauge of the TC,
the TC type, spool serial number, spool correction, and a check box for each of the TCs. There is also a
check box to allow the user to use the active settings for the TCs or to individually select the TCs to use on
the SDS instrument. Checking “Use these active TC settings” will set the checked TCs.
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Controller Information Tab

2 5DS Template Manager

File .
O d
ASDF.ixt @ C:\SSi\SDS\SurveyTemplates

~Templates Default
Add Template | L En

Templatelnformation] Suweylnformation] ActiveTCe  Contraller Infarmation

i Temperature Controller Information

Controller Mig: IContloIIer Mfg.

Controller Modet {1256

Instrument Type  |B

i PID Settings

Cycle Time: ]‘]D—'
Dead Band: ’Eﬁ‘n—‘
Olutput Lirnit: '?50—‘
FE [Gain): ﬁﬁg—
Rate: ]T5DD—‘
Feset: ’Eﬁq—‘

|T|
Delete | Copy |4¢,l

Figure 115 - Controller Information Tab

This tab contains information about the controllers such as the Controller Manufacturer, the
Controller Model, and the instrument type. It also contains information about the PID settings
such as the Cycle Time, the Dead Band, the Output Limit, the PB (gain), the Rate, and the Reset.
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Appendix 1: Quick Start Guide

The purpose of this Quick Start Guide is to provide a step-by-step guide to using the Color SDS
Data Logger for the very first time. More specifically, this guide provides a procedure for
preparing and using the data logger in survey operations beginning with receipt of shipment and
concluding with downloading data with SDS Reporter after the survey has been run and
generating reports. This guide provides concise information on unpacking, setting up, and
operating the Color SDS Data Logger, as well as downloading data and generating a report; for
more detailed information, please refer to specific sections of the manual.

Unpacking the Color SDS Data Logger

When you receive the Color SDS Data Logger, it will arrive in a box similar to the one shown
below.

Typical Box in Which Color Touch Screen Data Logger is Shipped

When the shipment arrives, move the box to a sturdy, elevated location (such as a table that can
support the weight of the data logger) with a working electrical outlet nearby and sufficient
room in which to work. When moving the box, employ proper safety precautions in order to
avoid personal injury.

Once the box containing the data logger has been placed on a sturdy work surface, you may
begin removal of the data logger from the box. First, using a utility knife or other appropriate
cutting instrument, cut the tape on top of the box. Then turn the box on its side and pull the box
flaps back, ensuring that there is enough clearance on the work surface that the data logger
will fit, with minimal risk of falling.
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Removing Data Logger from Box

Carefully remove the data logger and other contents from the box. Place the data logger flat on
the table, and set the box aside. The contents should include items shown in the picture below.

Color Touch Screen
Data Logger
Calibration Certificate

7

7/ 4

SI
o
Standard Contents of Box

Warming Up and Charging the Data Logger

If the data logger was recently brought indoors from a cold outside environment, allow the data
logger to warm up to the ambient temperature before plugging it in or turning it on. This will
help prevent condensation from forming on or inside the data logger and will help prevent
damage to electrical parts.

If the data logger has not been charged, first plug it into an electrical outlet using the electrical
cord provided. Allow the unit to charge until the charging light turns from red to green (green is
fully charged).
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Red — Charging Green — Charged

Charging Indicator on Data Logger

Turning on the Data Logger
Move the data logger to the survey area.

Turn on the data logger by turning the switch located
on the side of the unit to the "ON" position.

Power Switch in “ON” Position

The data logger will turn on. The touch screen will start. After a few minutes, the main Color
SDS Touch Screen menu will appear. Ensure that there are no error messages on the screen
after one minute of operation.

Connecting the Thermocouple Wires and Setting the Input Type
Connect the thermocouple wires to the input boards on the data logger.

Connecting Thermocouple Wires to Input Board

Set the Input Type (thermocouple wire type) using the Edit Input Types menu.
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Edit Input Types

|

Range Start: 1 Range End:

Set Range Input Types Return

Edit Input Types

Using Survey Templates

If a survey has been run previously, the data logger will default to the last survey template used.
To modify the template being used, access the Survey menu option. This option contains the
survey information and the controls to perform a survey.

Choose the appropriate template from the drop-down menu in the top right-hand corner.

The Edit Template button allows for changes to be made to the selected survey. When editing a
survey, pressing OK will make changes only for that particular survey, while pressing Save will
permanently change the template.

The View Surveys button will display a list of previous surveys from the selected time range.

Starting a Survey

Once the template has been selected and any necessary edits have been made, press Start
Survey to begin. This will timestamp the selection and the data logger will log all channels that
have been selected for logging.
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Survey Control

Default Template

Name Default Template -~
Company

MNotes

Furnace ID

Furnace Make/Model

Furnace Dimensions

Temperature Type

Furnace Range 0
|| Furnace Type
Furnace Use
Furnace Class
Survey Duration 0 I
Survey Tolerance 0.0

View Surveys

Edit Template

Survey Window

You may receive deviation alarms depending on the current input and setpoint as well as the

alarm settings. The survey continues to run. It is simply providing you with the information on
the display.

You can view the input channel data on a number of different screens. The Overview Display
option will display all channels on the device.

While the survey is running, several options are available: To stop the survey, select Complete

Survey from the Survey Control screen (which can be opened using the Survey option from the

main menu). Use Mark Approach to add a timestamp on when the furnace was heating up to its
target temperature. Use Mark Survey Startto mark when the survey began.

Survey Control

Survey Run Time: 1 second

QOUT of band HITC: 1 LOW TC: 3

STAB Timer (D:H:M) 0:0:0

Furnae Cliss -

Survey Duration 30

Survey Tolerance 750

Survey Simulated Load o

Survey Setpoint S00

Survey Operator Bob

Survey Spexification

umber of TCs 10

TC Gauge 5 ]
TC Type K

TC Spool SN

TC Spool Comection 00

Active Inputs 1 4,
| View Surveys View Chart

Complete Survey Mark Approach Mark Survey Start

Survey Control Window (visible from the data logger during a survey)

Click View Surveys to view data on past surveys. Click View Chartto view the current chart of
data being logged.
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Stopping Survey

When finished, select Complete Survey from the Survey Control screen (which can be opened
using the Survey option from the main menul).

Installing SDS Reporter

IMPORTANT: The person installing SDS Reporter must have administrative rights on the
computer(s) where the installation is taking place for the installation to be successful.

Double-click on the setup file, setup.exe, to start the auto-installation. (Avoid installing from
SDSSetup.msi, as this will not install prerequisites if necessary.) If there is no version of the
SDS Reporter running on the computer, the installation will prompt the user for the download
location.

iz SDS Reporter

Select Installation Folder

The installer will install SDS R eporter to the followvsing folder.

To install in this folder. click “MNext'. To install to a different folder. enter it below or click “Brovse’".

Ealder:
[c:nssisDs Browse... |

Diisk Cost... |

Install S0S Reporter for pourself. or for anvone who uses this computer:

i Ewernpone
€= Just me

Cancel I < Back I

SDS Reporter setup screen

Prerequisites for installing SDS Reporter include .NET Framework 2.0, SQL CE 3.5, and either
ActiveSync or Windows Mobile Device Center. The setup.exe program will check to make sure
that these prerequisites are installed and, if necessary, install them.

The default installation location is “C:\SSI\SDS". Click on the “Browse” button to select an
alternate location. Clicking on the “Disk Cost...” button will display the available computer
drives onto which the SDS Reporter can be downloaded, as well as the total space, available
space, and required space for each drive. Selecting the “Everyone” option will install the SDS
Reporter for all users on the computer, while selecting the “Just me” option will only install the
SDSReporter for the current user.

Click the “Next >” button to continue with the installation process.
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i SDS Reporter

Confirm Installation

The installer is ready to install SDS Reporter on wour computer

Click ""Mext" to start the installation.

Cancel [ e | s

Installation ready screen

Click on the “Next >" button to install the software to the specified location. Once the software
has been installed, close the installation program.

Connecting the SDS Data Logger to a Local Computer via USB

The data logger can be connected directly to a local computer using a USB cable. Windows uses
special software to transfer files and information between the data logger and the local
computer when connected via USB. If you are using Windows XP, this software is called
ActiveSync. If you are using Windows Vista or Windows 7, the software is called Mobile Device
Center. If the required software was not installed prior to installing SDSReporter, the
SDSReporter Setup utility (run from setup.exe) would have installed the required software.

Windows XP requires a driver for it to properly €2 Super, Systems inc. SDS Reporter
connect to the data logger’s color touch File SDS Options [
screen operating system. Install this driver, if About
necessary, by selecting the “Check Screen | octal Color Prorecpiites

) Yy, by . . g | Color Screen Driver Installation
Driver Installation” option under the Help Check For Lpdates
menu in SDSReporter, and then clicking “Start
Driver Installation” on the next screen.

Color Screen Driver Installation option

If you are using an older version of SDSReporter, be sure to update it by clicking “Check for
Updates”, also in the Help menu, and then downloading the update when prompted.

To connect the SDS Data Logger to a local computer with USB, first make sure that the data
logger is turned on and that the SDS software is running on the touch screen. Next, identify the
USB connection point used to connect the data logger to the local computer. To connect the
data logger to the computer, you will need a USB cable with cable ends that look like those
shown in the figure at right, below.
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Location of USB connection point for USB connection types
connecting data logger to local computer Standard-A (left), Standard-B (right)

Connect the SDS Data Logger to the local computer via USB. If you are connecting the data
logger to the computer via USB for the first time, you may see a message on the screen saying
that Windows is installing drivers, especially on Windows Vista and 7. Windows may also ask you
if you want to set up the device. If this happens, allow Windows to install the drivers, but close
the device setup window from ActiveSync or Mobile Device Center.

NOTE: If there is any question as to whether
the computer is detecting the data logger and
connecting to it properly, check the "My

Other

Computer” window in Windows XP or the !‘“ o 4 Portable Devices (1)
“Computer” window in Windows Vista and 7. .@ Mobile Device 5 CUWIN

The data logger should appear in this window

with a mobile or portable device icon, as Data Logger Device Icons in

shown at right. Other devices, such as Windows XP (left) and Windows 7/Vista (right)
smartphones, may also appear as part of the

same list.

Once the SDS Data Logger is connected to the computer via USB, start SDS Reporter.

Downloading Data with SDS Reporter

The “Color Screen Scanning” option must be checked B S DL SyslemEncaS i SRanorer
in order for SDS Reporter to scan for the Color SDS EidieRe
Data Logger. This scanning will take place over USB [ || mutple 5D5 Moge
using ActiveSync (Windows XP) or Mobile Device Show Labels on Chart

Center (Windows Vista/7). SRR

Color Screen Scanning Option

Open the Download Surveys and Data option in SDS Reporter. The software will begin to search
for any data loggers located on the network.
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£ §DS Data Downloader g@@

File  Ophions

SDS: | 5 Touch S SN SDSOM

Searching for SOS...
Firighed searching. Found 1 505,

Download |

SDS Data Log Extractor screen

Any data logger found on the network will be added to the drop-down list at the top of the
screen. If no devices are found, a message box will pop up letting the user know that no devices
were found on the network. Check the network connections to verify that any data logger and
computer are properly connected to the network.

SDSReporker x|

Mo S0S were Found, .,

No SDS devices found box

Under the Options > Download menu, the Download menu option will allow the user to choose
to download only data that has been used in surveys, or all of the logged data. (The SDS data
logger will log data continuously when it is on regardless if a survey is running or not. There
will be a check mark next to the menu option selected.) The default menu option is Only data
used in surveys. To download all data, make sure that Al/ datais checked.

<= 5D5 Data Downloader, E“E|E|

Download. .. 3 v Only data used in surveys reen SM SDS001
——  After Downloading,., ¥ all data

Sear Ditive »
Firished searching. Found T 505,

Download

Download menu option

Super Systems Inc. Page 100 of 104
Color Touch Screen Data Logger Operations Manual



Click the “Download” button. SDS Reporter will begin to download the survey data once the user
has clicked on the “Download” button. The button will read “Abort” while the data files are
downloading.

If you chose to only download data files used in surveys, and no data files are found, the
software will display an error message.

Mo surveys x|

@ Mo survey records were Found,

No survey records found box

The files will be downloaded to: SDS\(SDS Model number)\loglyear}—e.g.,
SDS\SDS505000\log2006.

= Data Downloader [ 64/127 1

SHS, | J

Downloading File: dataloge. 434 to CASSINSDSASDENSD 5001 Mog201 2hdataloge. 434 [1/15/2012 11:00:00 PM) Ba
Downloading File: datalogf. 434 ko CAS51S0SASDSVSDS001 \Mog201 2hdatalogf. 434 [1/16/2012 12:00:00 Ak]
Downloading File: datalogg. 434 to C:ASSNSDSASDSYSD 5001 Yog201 24hdatalogg. 434 [1/16/2012 1:00:00 Ak]
Downloading File: datalogh.434 to C:ASSINSDSASDENSD 5001 Mog201 24datalogh. 434 [1/16/2012 2:00:00 &M]
Downloading File: dataslogi 434 to C:ASSINSDSASD5AS D001 og201 24datalogi 434 [1/16/2012 3:00:00 k]
Downloading File: datalog) 434 to CASSISDENSDEAS D00 og200 24datalog) 424 [1/16/2012 4:00:00 &M]
Downloading File: datalogk. 434 to C:ASSINSDSASDESSDS001 Mog201 24datalogk. 434 [1/16/2012 5:00:00 &k]
Downloading File: datslogl. 434 to CASSINSDSASD5ASDS001 4 og201 24datalogl 434 [1/16/201 2 6:00:00 k]
Downloading File: datalagm. 434 to C:A55185D 545054505001 ag201 2\datalagn. 434 [1/16/2012 7:00:00 Akd]
D ownloading File: datalogn. 434 to C:ASSMSDSASDSYSD 5001 Yog201 24datalogn. 434 [116/2012 8:00:00 Akd]
Downloading File: datalogo.434 to C:ASSMSDSASDSYSD 5001 Yog201 24hdatalogo. 434 [1/16/2012 3:00:00 AM]
D awnloading File: datalogp.434 ta CASSINSDSASDSNSD 5001 Yag201 24datalagp. 434 [1/16/2012 10:00:00 AM)

| Abort

SDS Data Log Extractor progress

The software will display a continuous progress of the download status. Note: since there may
be a large number of files to download, this process may take several minutes to complete.

When all of the files have been downloaded, the words “Operation Complete” will be at the
bottom of the list, and the button at the bottom will read “Download”. A message box will also

be displayed reading “Operation Complete”. Click the OK button on the message box to close
the download data screen.

Once the data has been downloaded, it is available for reporting.

Generating a Report

Click on the File > New menu option to bring up the Report dialog. Reports use logged data and
the user specified interval in the report. The report template that is selected will form the final
report view with all of the template data, survey data, and additional report parameters that are
entered. All reports can be saved and displayed at a later date.

Super Systems Inc. Page 101 of 104
Color Touch Screen Data Logger Operations Manual



£33 Super Systems inc. SDS Reporter

File SD5 Options Help

MEENE

Report Propertiesl Chartl Data I

Report ISurvey Parameters | Survey Details | Thermocouples | Survey Box I Furnace | Contraller I User Defined -Comparisonchedc Cornparisonchedtzl

—Data Sources

Data | |_|
Report Template: | |_|

—5D5 Report
Report Heading f Title | |

Survey Results (Pass/Fail) | |

—MNotes

Report Window

After bringing up the Report window, you must select a data source. To do this, click the
button next to the Data field. A screen similar to the one below will appear.

&2 | pad Survey Data

Data Interval 1 Mirute il

80/2012 10048 AM - 11:12 AW Default changed: [company m-idm] [SDS001]
TA2/2012 526 P - 340 AW Default Template: [SDS001]
TH2/20125:23PM - 525 PM  Default Template: [SDS001]

Advanced: Manually Create a Survep Becaord

Catcel (NE

Load Survey Data Window

Select the survey data source on which you want to base the report that SDSReporter will
generate. Click “Use”. The Data field will be populated with the data source you selected.

Next, click the J next to the Report Template field. An Open window will appear similar to the
one in the figure below.
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Loaok in: | ) ReportTemplates ﬂ ﬁ Ea-
5 Sample Report Template
My Recent
Documents Lookine [ RepontTemplates Bdl
) (5 My Recent Documerts
Q 5 [ Desktop
=
[ My Docurments
R t
e [Fecert |2 My Computer
I 43 3 Floppy &)
3 e Local Disk [C:)
7 = 58l
eskiop
tdy Documents Q@E‘DS
-
5o
4y Computer
<)
=
My Metwork File name: | j Open
Places
Files of type: [Rich T ext Files *t) ~| Cancel

Report Template Open Window

Select the Sample Report Template. The Data and Report Template fields will now be
populated, as shown in the figure below.

2 Super Systems inc. SDS Reporter

File 3DS Options  Help

NEIEIR

Report Properties I Chart I Data I

Repart ]Survey Parameters ] Survey Details ] Thermocouples | Survey Box I Furnace 1 Controller I User Defing

Data Sources

Data ‘8;‘10;’2012 10:48 AM - 11:12 AM Default changec‘ |

Report Template: ‘C:\SSI\SDS\REpUrtTemp\ates\Samp\e Report Tam‘ |

SDS Report
Report Heading | Title ‘ ‘

Survey Resulks (Pass/Fail) ‘ ‘

Motes I
nokes <3

Report Properties > Report Tab with Data and
Report Template Fields Populated

Once the Data and Report Template fields are populated with accurate data, SDS Reporter
performs a number of reporting functions. Additional tabs provide additional functionality and
options. These are covered in detail in the SDS Reporter section. Two of the most commonly
used functions are printing a report and saving report files.

Print a report by selecting File > Print > Print Report, as shown below.
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2 Super Systems inc. SDS Reporter

58 SDS Options Help

Hew J

Cpen B

Save Chart l Data I

Save A5 e ————
Export ) rameters ] Survey Details ] The

I BT
Print Preview  » Print Survey TC Data

. Print Approach TC Data
Exit

Lnl | ™7

Print all

Print Multiple Surveys

Print Report option

Save a report for future reference by selecting File > Save As, entering a file name, and clicking
“Save”. All report files are saved with the default file extension .sdsreport.

Save As El gl

Save in: |J SDSReports ﬂ IfF E-

2. \ﬂ Example Survey

My Recent
Documents

@

Desktop

My Documents

-
58
by Computer
MyPI[Lecholk File name: ‘Quick Start Saved Survey j Save |
Save as type: ‘SDSF\epnrl File j Cancel
Report “Save As” Window
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